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Chapter 1

Introduction

This chapter includes a brief description of IBM’s Customer Information Control 
System™ (CICS™), and an overview of the SeeBeyond CICS eWay Intelligent Adapter.

What’s in This Chapter

CICS Transaction Server on page 8

The eWay Intelligent Adapter for CICS on page 9

z/OS CICS Security Considerations on page 12

About This Document on page 14

SeeBeyond Web Site on page 15

1.1 CICS Transaction Server
IBM’s Customer Information Control System (CICS), is IBM’s most widely used 
proprietary, transaction monitor. CICS provides connectivity and online transaction 
management for mission-critical applications. It supports real-time distributed 
processing environments and online transaction processing (OLTP). According to IBM, 
CICS handles more than thirty billion transactions, processing more than one trillion 
dollars, per day. 

CICS is the premier OLTP (On-Line Transaction Processing) product from IBM. It is 
used to access many file systems and databases including third party products. For IBM 
product, it interfaces with DB2, VSAM and IMS/DB. For non-IBM products, it 
interfaces with IDMS, ADABAS, DATACOM, to name a few. Most applications in CICS 
are written in COBOL, although it supports other languages such as PL/1.

OLTP systems provide accurate, up-to-date information within seconds, from terminals 
that give direct access to data held as either files or databases. CICS provides a 
company with numerous transaction processing and resource management functions, 
allowing the user to concentrate on developing application programs that meet that 
organization's specific business needs. CICS controls OLTP application programs in a 
distributed transaction processing (DTP) environment. CICS handles interactions 
between the terminal user and the application programs. Programs gain access to the 
CICS facilities with straightforward, high-level commands.
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CICS provides:

Communicationfunctions to terminals and systems required by application 
programs 

Control of concurrently running programs serving online users

Facilities for accessing databases and files 

The ability to communicate with other CICS family members using Transmission 
Control Protocol/Internet Protocol (TCP/IP) 

Interactive facilities to configure specific systems 

Recovery processing and data protection, should a problem occur 

1.2 The eWay Intelligent Adapter for CICS
The eWay Intelligent Adapter for CICS is an interface that enables remote bidirectional 
calls to CICS transactional programs. The CICS eWay includes a build tool, the Cobol 
Copybook Converter, that creates an Object Type Definition (OTD) from a Cobol 
Copybook file and generates eGate Object Type Definitions for use within the eGate 
environment. The Copybook file structures are passed into the CICS environment as 
the data buffer (Commarea). 

A fixed Object Type Definition, the CICS_eWay.CICSClient OTD, designed to expose 
various essential portions of the CICS Java API, provides available methods and 
properties, as well as access to all message attributes. 

The eWay can use either the IBM CICS Transaction Gateway 5.1 or the SeeBeyond 
CICS Listener as the underlying connection transport for accessing CICS z/OS 
transactions.

IBM CICS Transaction Gateway (CTG)

CTG provides an API (the External Call Interface or ECI) to call CICS transactions on 
the mainframe. The ECI allows a non-CICS application program to call a CICS program 
in a CICS server. SeeBeyond’s CICS eWay uses this ECI method to connect to CICS. The 
CICS eWay connects to CICS with CTG running on a local-host (Figure 1), on a second 
computer (Figure 2 on page 10), or on the mainframe (Figure 3 on page 10). 
CICS eWay Intelligent Adapter User’s Guide 9 SeeBeyond Proprietary and Confidential
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Figure 1   eGate and CTG running on the same host

Figure 2   Remote connection with CTG on a UNIX or Windows host

Figure 3   eGate connects with CTG running on the mainframe

Note: When using the CICS Transaction Gateway transport, data sent to CICS must be 
padded with spaces, if necessary, to match the full size of the commarea.
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SeeBeyond CICS Listener (STCL)

The CICS eWay connects to the IBM CICS Listener running on z/OS via the TCP/IP 
Sockets. The Listener accepts the incoming request and spawns a new process handing 
the socket connection off to the newly created process via TCP/IP givesocket()/
takesocket() function calls. The spawned process invokes the user written CICS 
application program through an EXEC CICS LINK. 

Figure 4   Using the SeeBeyond CICS Listener for Synchronous Transactions

The CICS eWay (Java version) communicates with SeeBeyond CICS Listener for 
Synchronous Transactions (See Figure 4) as follows:

1 An incoming Connect request is handled by the IBM CICS Socket Listener, which 
starts the SeeBeyond CICS Listener Transaction STCL and hands off the incoming 
connection via the IBM TCP/IP Give Socket and Take Socket interface.

2 The SeeBeyond CICS Listener allocates a CICS COMMAREA and copies 
information from the CICS eWay COMMAREA to the actual CICS COMMAREA.

3 The SeeBeyond CICS Listener issues an EXEC CICS LINK to requested CICS 
Transaction Program passing it the newly allocated COMMAREA.

4 The requested CICS Transaction obtains data from the COMMAREA, performs 
typical business rule processing and then returns its results in the COMMAREA 
and returns control back to the SeeBeyond CICS Listener.

5 The SeeBeyond CICS Listener copies information from the CICS COMMAREA back 
to the CICS eWay COMMAREA.

6 The SeeBeyond CICS Listener goes into a listen mode and waits for the next 
incoming Transaction Program request.

The process continues until the SeeBeyond CICS Listener Timeout is exceeded or a 
disconnect request is received from the CICS eWay.

CICS
eWay

z/OS

TCP/IP

CICS
Socket
Listener

CICS
Transaction

Program

COMMAREA

S
T
C
L 2

1

CICS Region

3

4 5

1

CICS eWay Intelligent Adapter User’s Guide 11 SeeBeyond Proprietary and Confidential



Chapter 1 Section 1.3
Introduction z/OS CICS Security Considerations
1.3 z/OS CICS Security Considerations

Security Considerations for SeeBeyond CICS Listener

The CICS eWay, using the SeeBeyond CICS Listener as the underlying connection 
transport, utilizes three modes of security with z/OS: Connection Logic, Request Link 
to Program, and Request Start Transaction. The userID and password are defined in the 
eWay properties file. The connection manager uses the userID and password in the 
properties file to start the SeeBeyond CICS Listener on z/OS. During Business Rules 
processing, requests that flow into the SeeBeyond CICS Listener can use the userID and 
password from the properties file, or can be overwritten in the Collaborations. 

Figure 5   Connection Logic

Connection Logic

For the Connection Logic mode (Figure 5), the userID and password, passed from the 
CICS eWay through the IBM CICS listener and into the SeeBeyond CICS Listener, must 
be defined for the z/OS security system (RACF, for example). The userID must be 
authorized by the z/OS security system to run CICS transaction “xxxx” inside of CICS. 
The default value for “xxxx” is STCL, and can be changed in the properties of the 
Connection Manager in the CICS eWay.

Figure 6   Business Rules Request to Program
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Request Link to Program

For the Request Link to Program mode (Figure 6 on page 12), the userID and password 
passed from the CICS eWay to the SeeBeyond CICS Listener must be defined for the z/
OS security system (RACF, for example). The userID must be authorized by the z/OS 
security system to run CICS program “prog1” inside of CICS. The default value for 
“prog1” is set in the properties of the CICS eWay, and can be overridden in the 
Collaboration for each request sent into the SeeBeyond CICS Listener.

Figure 7   Business Rules Request Start Transaction

Request Start Transaction

For the Request Start Transaction mode (Figure 7), the userID and password passed 
from the CICS eWay to the SeeBeyond CICS Listener must be defined for the z/OS 
security system (RACF, for example). The userID must be authorized by the z/OS 
security system to start CICS transaction “TRN1” inside of CICS. The default value for 
“TRN1” is set in the properties file of the CICS eWay, and can be overridden in the 
Collaboration for each request sent into the SeeBeyond CICS listener.

Security Considerations for IBM CICS Transaction Gateway

For information on CICS Transaction Gateway 5.1 security validation refer to the 
following:

IBM documentation CICS Transaction Gateway z/OS Administration or the CICS 
Transaction Gateway V5.1 Administration Guide for your specific operating system, 
available at:

http://www-306.ibm.com/software/htp/cics/library/cicstgv5.html

Readme.txt for CTG 5.1 provided on the CTG 5.1 installation CD_ROM
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1.4 What’s New in This Release
Version 5.0.4 is a maintenance release of the CICS eWay. This user’s guide includes the 
following changes:

Support for z/OS V1.3 and V1.4 (see Supported Operating System on page 16).

1.5 About This Document
This section provides a brief outline of the CICS eWay User’s Guide.

1.5.1. Organization of Information
This book includes the following chapters:

Chapter 1 “Introduction” provides an overview of the CICS eWay Intelligent 
Adapter, including a brief description of CICS Transaction Gateway, SeeBeyond 
CICS Listener, and CICS eWay security for z/OS.

Chapter 2 “Installing the CICS eWay” provides the supported operating systems 
and system requirements for the CICS eWay. It also includes directions for installing 
the CICS eWay, installing and configuring the SeeBeyond CICS Listener, and 
accessing the accompanying documentation and sample projects.

Chapter 3 “Configuring the CICS eWay” describes the process of configuring the 
CICS eWay to run in your environment.

Chapter 4 “Using eInsight Business Processes with the CICS eWay” describes 
how to use the CICS eWay with the ICAN Suite’s eInsight Business Process 
Manager and the Web Services interface.

Chapter 5 “Implementing a CICS eWay Project” describes the features and 
functionality of the CICS eWay using the eGate Integrator and the Collaboration 
Editor (Java). 

Chapter 6 “Java Methods” describes the CICS eWay’s Java classes and provides 
directions for accessing the CICS eWay Javadoc.

1.5.2. Scope of the Document
This user’s guide provides a description of the CICS eWay Intelligent Adapter. It 
includes directions for installing the eWay, configuring the eWay properties, and 
implementing the eWay’s sample projects. This document is also intended as a 
reference guide, listing available properties, functions, and considerations. For a 
reference of available CICS eWay Java methods, see the associated Javadoc.
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1.5.3. Intended Audience
This guide is intended for experienced computer users who have the responsibility of 
helping to set up and maintain a fully functioning ICAN Suite system. This person 
must also understand any operating systems on which the ICAN Suite will be installed 
and must be thoroughly familiar with Windows-style GUI operations.

1.5.4. Document Conventions
The following conventions are observed throughout this document.

1.6 SeeBeyond Web Site
The SeeBeyond Web site is your best source for up-to-the-minute product news and 
technical support information. The site’s URL is:

http://www.seebeyond.com 

1.7 SeeBeyond Documentation Feedback
We appreciate your feedback. Please send any comments or suggestions regarding this 
document to:

docfeedback@seebeyond.com

Table 1   Document Conventions

Text Convention Example

Button, file, icon, parameter, 
variable, method, menu, and 
object names.

Bold text Click OK to save and close.
From the File menu, select Exit.
Select the logicalhost.exe file.
Enter the timeout value.
Use the getClassName() 
method.
Configure the Inbound File 
eWay.

Command line arguments 
and code samples

Fixed font. Variables 
are shown in bold 
italic.

bootstrap -p password

Hypertext links Blue text http://www.seebeyond.com
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Chapter 2

Installing the CICS eWay

This chapter contains installation information for the CICS eWay. 

In addition, this chapter also includes information for installing and configuring the 
SeeBeyond CICS Listener and IBM CICS Transaction Gateway. One of these must be 
installed and configured as the underlying connection transport for accessing z/OS 
CICS transactions. 

What’s in This Chapter

Supported Operating System on page 16

System Requirements on page 17

Installing the CICS eWay on page 18

SeeBeyond CICS Listener Installation for z/OS on page 19

SeeBeyond CICS Listener Configuration Maintenance for z/OS on page 24

CICS Listener Considerations for Invoking DB2 Applications on page 40

CICS Transaction Gateway 5.1 Installation and Configuration on page 42

2.1 Supported Operating System
The CICS eWay is available on the following operating systems:

Windows 2000, Windows XP, and Windows Server 2003

HP-UX 11.0, 11i (PA-RISC), and 11i V2 (11.23)

IBM AIX 5.1L and 5.2

IBM z/OS V1.3 and V1.4

Sun Solaris 8 and 9

Also Supported

The CICS eWay also supports CICS Transaction Server residing on the following 
operating systems:

OS/390 V2R10 or z/OS V1.3 and above (any reference to z/OS in this document 
includes OS/390 V2R10) 
CICS eWay Intelligent Adapter User’s Guide 16 SeeBeyond Proprietary and Confidential
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2.2 System Requirements
The system requirements for the CICS eWay are the same as those for eGate Integrator. 
For information, refer to the SeeBeyond ICAN Suite Installation Guide. It is also helpful to 
review the Readme.txt for any additional requirements prior to installation. The 
Readme.txt is located on the installation CD-ROM.

Although the CICS eWay, the Repository, and Logical Hosts run on the platforms listed 
under Supported Operating Systems, the Enterprise Designer requires the Windows 
operating system. The Enterprise Manager can run on any platform that supports 
Internet Explorer 6.0.

2.3 External System Requirements
Software Requirements

IBM CICS Transaction Server version 1.3, 2.1, or 2.2

An underlying connection transport using either of the following

IBM CICS Transaction Gateway 5.1 (see Requirements for the CICS Server 
using CICS Transaction Gateway on page 17)

SeeBeyond CICS Listener (see Requirements for the CICS Server Using the 
SeeBeyond CICS Listener on page 17) 

Requirements for the CICS Server using CICS Transaction Gateway

For directions on configuring CICS Transaction Gateway 5.1 to communicate with a 
CICS server over a TCP/IP usingTCP62, see the “Setting Up Client/Server 
Communications” section of the CICS Transaction Gateway Administration manual for 
your specific platform available at:

http://www-306.ibm.com/software/htp/cics/library/cicstgv5.html

Requirements for the CICS Server Using the SeeBeyond CICS Listener 

To enable the eWay to communicate correctly with CICS using the SeeBeyond CICS 
Listener the following are required:

OS/390 V2R10 or above (see System Requirements on page 17)

Resource Access Control Facility (RACF) or an equivalent security product

IBM CICS Transaction Server version 1.3 or 2.1

IBM MVS TCP/IP socket runtime libraries, installed and configured for each CICS 
region in which the SeeBeyond CICS Listener will be run. For more information 
please refer to IBM’s TCP/IP V3R2 for MVS: CICS TCP/IP Socket Interface Guide. 

COBOL for z/OS and Language Environments
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SeeBeyond CICS Listener Requirements for Invoking DB2 Applications

There are two different techniques that can be used for invoking DB2 application 
programs through the SeeBeyond CICS Listener. 

RCT entry for the STCL SeeBeyond CICS Listener Transaction

PPT entry to redirect DB2 application to another AOR (Application Owning 
Region) 

For detailed information refer to CICS Listener Considerations for Invoking DB2 
Applications on page 40.

2.4 Application Server Support
The CICS eWay in Outbound mode is supported on WebSphere™ and WebLogic™ 
Application Servers when using Java Collaborations only. See the eGate Integrator 
User's Guide for additional information regarding the running of this eWay on this 
Application Server.

2.5 Installing the CICS eWay 
During the ICAN Suite installation process, the Enterprise Manager, a web-based 
application, is used to select and upload eWay and Add-on files (.sar files) from the 
ICAN installation CD-ROM to the Repository. 

When the Repository is running on a UNIX operating system, the eWays are loaded 
using the Enterprise Manager on a Windows computer connected to the Repository 
server using Internet Explorer.

2.5.1. Installing the CICS eWay on an eGate supported system
The ICAN Suite installation process includes the following operations:

Install the eGate Repository

Upload products to the Repository

Download components (including the eGate Enterprise Designer and Logical Host)

Follow the directions for installing the ICAN Suite in the SeeBeyond ICAN Suite 
Installation Guide. After you have installed eGate and any other purchased core 
products, do the following:

1 From the Enterprise Manager’s ADMIN tab, browse to the Add-ons directory and 
select the ProductsManifest.xml, and click Submit. The available Add-on product 
list is now displayed.

2 Browse to and select the following files located in the Add-ons directory:
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FileeWay.sar (to install the File eWay, used in the sample project)

CICSeWay.sar (to install the CICS eWay)

3 Click upload now to upload the selected products.

4 Click on the Manifest File field’s Browse option, browse to the Add-ons > 
Documentation directory, select the ProductsManifest.xml, and click Submit. The 
available Add-on documentation list is now displayed.

5 Select and upload the following file:

CICSeWayDocs.sar (to upload the CICS eWay User’s Guide, Javadoc, Readme, 
and sample projects to the Enterprise Manager).

6 Click upload now to upload the selected product.

7 Continue installing the eGate Integrator as instructed in the SeeBeyond ICAN Suite 
Installation Guide. 

Adding the eWay to an Existing ICAN Suite Installation

If you are installing the eWay to an existing ICAN installation, do the following:

1 Complete steps 1 through 6 above.

2 Open the Enterprise Designer and select Update Center from the Tools menu. The 
Update Center Wizard appears.

3 For Step 1 of the wizard, simply click Next.

4 For Step 2 of the wizard, click the Add All button to move all installable files to the 
Include in Install field. Click Next.

5 For Step 3 of the wizard, wait for the modules to download, then click Next.

6 The wizard’s Step 4 window displays the installed modules. Click Finish.

7 When prompted, restart the IDE to complete the installation. 

After Installation

Once the eWay is installed and configured it must then be incorporated into a project 
before it can perform its intended functions. See the eGate Integrator User’s Guide for 
more information on incorporating the eWay into an eGate project.

The CICS eWay User Guide, Javadoc, Readme, and sample projects, can be accessed 
from the Enterprise Manager’s Documentation tab. 

2.6 SeeBeyond CICS Listener Installation for z/OS
The following section provides directions for installing the SeeBeyond CICS Listener to 
an OS/390 or z/OS operating system from the installation CD-ROM or from a 3480 
Tape. Directions are also included for installing CICS CEDA definitions, adding the 
CICS eWay load modules to the CICS DFHRPL concatenation, and using the 
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SeeBeyond CICS Listener monitoring screen to verify that all components are properly 
installed and working correctly.

2.6.1. Downloading the SeeBeyond CICS Listener Zip File
The SeeBeyond CICS Listener ZIP file, CICS_Listener.zip can be downloaded from the 
ICAN Installation CD-ROMs. To download the CICS_Listener.zip to your computer do 
the following:

1 Locate the Products installation CD-ROM containing the CICSeWay.sar file. 

2 Open the CD-ROM to view and locate the CICSeWay.sar file. 

3 Right-click the CICSeWay.sar file, and from the shortcut menu, select the “Open 
With” option and select a zip program such as WinZip™.

4 From the opened CICSeWay.sar file, click on and drag the CICS_Listener.zip file to 
your Desktop. Close the zip program. The CICS_Listener.zip file is now available 
from your computer’s Desktop file.
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2.6.2. Installing the SeeBeyond CICS Listener from CD for z/OS
These following describes how to restore the SeeBeyond CICS Listener files from the 
CICS_Listener.zip file to your MVS system in a usable state. The files are packaged on 
MVS for transfer using the TSO transmit (XMIT) command to transmit them into a data 
set. This is done to turn a PDS into FB 80 files which can be sent by FTP. Files are 
downloaded to a computer and then compressed with PKZIP.

1 Download the CICS_Listener.zip file to your PC (see Downloading the 
SeeBeyond CICS Listener Zip File on page 20), and unzip the files using a zip 
program such as WinZip. 

2 Create two MVS datasets to receive the files, as follows:

//DD1    DD DSN=USER.XMIT.CICSLOAD,
//          DISP=(NEW,CATLG,DELETE), 
//          RECFM=FB,LRECL=80,BLKSIZE=3120,DSORG=PS,
//          SPACE=(3120,(48,5)),
//          UNIT=diskunit

//DD2    DD DSN=USER.XMIT.JCLLIB,
//          DISP=(NEW,CATLG,DELETE), 
//          RECFM=FB,LRECL=80,BLKSIZE=3120,DSORG=PS,
//          SPACE=(3120,(30,5)),
//          UNIT=diskunit

3 Upload (FTP, IND$FILE) the unzipped files to MVS using a binary file transfer 
method (no CRLF or ASCII translation).

4 Restore the files to PDS by using the Receive command on MVS. 

5 Issue command: TSO RECEIVE INDATASET(uploaded.dataset) 

6 When prompted by the message: 

INMR906A Enter restore parameters or 'DELETE' or 'END' + 

enter:

DA(name.of.your.library) UNIT(unit) VOLUME(volume) 

Note: The UNIT() and VOLUME() operands are optional but shown in case your 
installation requires them.

We suggest using the following names for your received datasets:

STC.XMIT.CICS.CICSLOAD 
STC.XMIT.CICS.JCLLIB 

These names match our documentation. Change them as your facility requires.
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2.6.3. Installing the SeeBeyond CICS Listener from 3480 Tape
The SeeBeyond CICS Listener installation for OS/390 or z/OS is provided on an 
installation tape containing the following datasets (Table 2):

Copying the Tape Contents to Disk

1 Create, customize, and submit the following job to copy the RESTORE JCL to disk:

1  //JOBNAME JOB (SYSTEM),'SYSPROG',NOTIFY=&SYSUID,REGION=6M,
2  //  CLASS=A,MSGLEVEL=(1,1),MSGCLASS=X 
3  //* 
4  //* COPY SAMPLE JCL TO DISK 
5  //* 
6  //IEBGENER EXEC PGM=IEBGENER 
7  //SYSPRINT DD SYSOUT=* 
8  //SYSUT1 DD DSN=TAPE.STC.RESTORE.JCL, 
9  // UNIT=tapeunit, 
10 // VOL=SER=STC390, 
11 // LABEL=(1,SL,,,EXPDT=98000), 
12 //  DISP=OLD 
13 //SYSUT2 DD DSN=customer.dataset, 
14 // SPACE=(TRK,(10,10),RLSE), 
15 // UNIT=diskunit, 
16 // VOL=SER=diskvol, 
17 // DCB=(LRECL=80,BLKSIZE=3120,RECFM=FB), 
18 // DISP=(NEW,CATLG,DELETE) 
19 //SYSIN DD DUMMY 

2 Edit the fore mentioned code for your system as follows:

A Replace the Jobcard in the first two lines with one that meets your installation 
standards.

B Replace tapeunit in line 9 with the unit name of your tape drive: for example, 
UNIT=TAPE.

C Some Tape Management systems require an EXPDT value (see line 11) to 
indicate a foreign tape.

D Specify a customer.dataset name (see line 13) that meets your installation 
standards.

E Specify a unitname for the disk (replacing diskunit in line 15), to meet your 
installation standards: for example, UNIT=3390.

F Specify the volume serial number of the disk (replacing diskvol in line 16), 
where the dataset is to be created.

Table 2   Tape Contents

File Dataset Name Contents

1 TAPE.STC.RESTORE.JCL JCL sample to load this tape to disk 
(RESTORE JCL).

2 TAPE.STC.CICS.JCLLIB Installation jobs and control cards for 
the CICS eWay.

3 TAPE.STC.CICS.CICSLOAD Load library that containing the load 
modules for the CICS eWay.
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3 Once the job has completed successfully, customize and submit the sample JCL in 
CUSTOMER.DATASET job to copy the entire contents of the installation tape to 
disk. Customize displayed in the first 15 lines below

1  //JOBNAMEx JOB (SYSTEM),'SYSPROG',NOTIFY=&SYSUID,REGION=6M,             
2  //   MSGLEVEL=(1,1),MSGCLASS=X,CLASS=A                             
3  //*                                                                     
4  //TAPECOPY PROC PREFIX=custpref,<== CUSTOMER HIGH LEVEL QUALIFIER     
5  //        TAPEUNIT=tapeunit,   <== UNIT NAME FOR TAPE DRIVE           
6  //        DISKUNIT=3390,       <== UNIT NAME FOR DISK DRIVE           
7  // VOLSER=diskvol,      <== DISK VOLUME FOR INSTALL DATASETS   
8  //        LOADBLK=TRK, <== BLOCKING FACTOR FOR CICS LOAD     
9  //        LOADPRI=45,      <== PRIMARY ALLOCATION FOR CICS LOAD   
10 //        LOADSEC=15,      <== SECONDARY ALLOCATION FOR CICS LOAD 
11 //        LOADDIR=10,      <== DIRECTORY BLOCKS FOR CICS LOAD     
12 //        JCLLBLK=TRK,      <== BLOCKING FACTOR FOR JCL LIBRARY   
13 //        JCLLPRI=1,      <== PRIMARY ALLOCATION FOR JCL LIBRARY 
14 //        JCLLSEC=1,      <== SECONDARY ALLOCATION FOR JCL LIB   
15 //        JCLLDIR=10      <== DIRECTORY BLOCKS FOR JCL LIBRARY:

A Replace the Jobcard in the first two lines with one that meets your installation 
standards.

B Change the custpref value (see line 4) in the TAPECOPY procedure to a high-
level-qualifier for your installation datasets.

C Replace tapeunit in line 4 with the unit name of your tape drive: for example, 
TAPEUNIT=TAPE.

D Change the 3390 for the DISKUNIT in line 6, to meet your installation standards: 
for example, DISKUNIT=SYSDA.

E Specify the volume serial number of the disk (replacing diskvol in line 7), where 
the dataset is to be created.

2.6.4. Creating the STCCLCFG File
Customize the Jobcard and Dataset names, and submit the STCCLCFG job found in 
JCLLIB. 

2.6.5. Installing the CICS CEDA Definitions
Customize the file definition in the JCLLIB member CEDALCFG to conform to your file 
naming conventions, and to match the file name created in the previous step. 
Customize and submit job STCLCEDA to create CICS CEDA definitions for the eWay.

Using the CICS RDO interface, install the new definitions in group STCLSN into CICS, 
and add the group name STCLSN, to your start-up list.

2.6.6. Adding the CICS eWay Load Modules to CICS DFHRPL 
Concatenation

Add the following data set to the DFHRPL concatenation under CICS:

// DD DSN=&PREFIX..STC.CICS.CICSLOAD,DISP=SHR

Note: Remember to re-cycle your CICS region to pick up this new library.
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2.7 SeeBeyond CICS Listener Configuration Maintenance 
for z/OS

After the STCCLCFG Configuration File has been created and the CEDA file definition 
has been installed, use the SeeBeyond CICS Configuration File Maintenance screen to 
view and update the contents of the STCCLCFG configuration file.

1 Logon to the CICS region that the SeeBeyond Listener is running in. Clear the 
screen, type in stlc as shown in Figure 8, and press Enter.

Figure 8   

2 The Configuration File Maintenance screen appears as displayed in Figure 9.

Figure 9   
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3 The fields of the Listener Configuration Maintenance screen are described as 
follows:

Generate verbose debug tracing for STCCLSN:This flag controls the logging 
of debug tracing messages issued by the STCCLSN SeeBeyond CICS Listener 
Program. These tracing messages are written to the LLOG transient data queue.

If the “Write messages to the LLOG listener log queue” field on this screen is 
turned off, then debug tracing will NOT be logged. 

Y: yes, log debug tracing messages.

N or blank: no, do not log debug tracing messages.

Generate verbose debug tracing for STCCLQS:This flag controls the logging 
of debug tracing messages issued by the STCCLQS SeeBeyond CICS Listener 
Query Security Program. These tracing messages are written to the LLOG 
transient data queue. 

If the “Write messages to the LLOG listener log queue” field on this screen is 
turned off, then debug tracing will NOT be logged.

Y: yes, log debug tracing messages.

N or blank: no, do not log debug tracing messages.

Verify userid/password during STCL listener transaction startup:This flag 
controls userid/password verification at the STCL SeeBeyond Listener 
Transaction startup. The userid and password are passed from the CICS eWay 
to the IBM Listener program in the user area of Connection Request Record. The 
IBM Listener passes this user area to the SeeBeyond CICS Listener when it 
spawns it as a child listener task. 

If this flag is turned on, the SeeBeyond Listener Program startup logic issues a 
Verify Password command to check whether the userid is defined for the RACF 
or any equivalent security system, and if the password is valid and current.

Y: yes, verify userid/password.

N or blank: no, do not verify userid/password.

Query Security during STCL listener transaction startup: This flag controls 
Query Security processing at the STCL SeeBeyond Listener Transaction startup. 
The userid and password are passed from the CICS eWay to the IBM Listener 
program in the user area of Connection Request Record. The IBM Listener 
passes this user area to the SeeBeyond CICS Listener when it spawns it as a 
child listener task. 

If this flag is turned on, the SeeBeyond Listener Program startup logic invokes 
the STLQ SeeBeyond Listener Query Security transaction to check if the userid 
is authorized to run the STCL SeeBeyond Listener transaction.

Y: yes, perform Query Security processing.

N or blank: no, do not Query Security processing
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Verify userid/password for each business rules transaction record: This flag 
controls userid/password verification for each Business Rules transaction sent 
in from the CICS eWay. The userid and password are passed in from the CICS 
eWay in the Application Control Record (ACR) that contains the Business Rules 
transaction data.

If this flag is turned on, the SeeBeyond CICS Listener program Business Rules 
logic issues a Verify Password command to check whether the userid is defined 
for the RACF or any equivalent security system, and if the password is valid 
and current.

Y: yes, verify userid/password.

N or blank: no, do not verify userid/password.

Query Security for each business rules transaction record: This flag controls 
Query Security processing for each Business Rules transaction sent in from the 
CICS eWay. The userid and password are passed in from the CICS eWay in the 
Application Control Record (ACR) that contains the Business Rules transaction 
data. 

If this flag is turned on, the SeeBeyond CICS Listener Program Business Rules 
logic invokes the STLQ SeeBeyond Listener Query Security transaction to check 
whether the userid is authorized to run the requested customer application 
program or transaction that is specified in the ACR.

Y: yes, perform Query Security processing.

N or blank: no, do not Query Security processing.

Write messages to the LLOG listener log queue: This flag controls the logging 
of messages to the LLOG listener log queue. 

If this flag is turned off, NO messages (normal information as well as debug 
tracing) will be written by either the STCCLSN (SeeBeyond CICS Listener) or 
STCCLQS (SeeBeyond Listener Query Security) programs.

Y: yes, write log messages to the LLOG listener log queue.

N or blank: no, do not write log messages to the LLOG listener log queue.

Suppress RACF messages generated by Query Security commands: This flag 
controls RACF informational message logging for Query Security exceptions.

If this flag is turned off, then every Query Security command that results in a 
negative result for Control, Alter, Update, or Read will cause respective RACF 
information messages to be written to the system message log. This could create 
unnecessary, high volume logging on the system message log files. 

It is recommended that this flag be turned off for debugging or low volume 
testing purposes only. 

In a production environment, it is recommended that this flag be turned on to 
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suppress the RACF informational messages generated by Query Security 
exception conditions.

Y: yes, suppress RACF messages generated by Query Security processing. 

N or blank: no, do not suppress (in other words, allow) RACF messages to 
be generated by Query Security processing.

Timeout value for invoking STCCLQS: This value is used to control the 
amount of time the STCCLSN SeeBeyond CICS Listener program waits for the 
STLQ Listener Query Security Transaction to return a response. Valid values are 
0000 to 9999. Since the STLQ transaction, under normal CICS processing 
conditions, executes within one second, it is recommended that the value be set 
above 1 and below 10. However, if the CICS region that the SeeBeyond CICS 
Listener is running in experiences occasional performance bottle necks, you 
may choose to set this value higher to avoid unnecessary STLQ timeout errors 
during peek load conditions.

This value does not affect the time STLQ takes to respond. It simply sets a 
timeout threshold above which the STCCLSN stops waiting for a response from 
STLQ and issues an error message back to the CICS eWay indicating that an 
STLQ timeout has occurred. For example, if this timeout value is set to 5, and 
STLQ executes in 1 second, then STCCLSN will “wake up” after 1 second, not 
the full 5 seconds. 

4 The pfkeys for this screen are as follows:

PF3: exit.

PF4: commit the updates on the screen to the STCCLCFG file and update all 
existing Listener Program Areas (LPA's) in CICS storage.

Enter: validates the onscreen data for errors.

The user may make any necessary changes, then use the Enter key to validate any 
new values that have been entered. IF no error conditions occur for the data on the 
screen, then the user must press the PF4 key to commit the updates to the 
STCCLCFG Listener Config VSAM File. The updated screen appears as displayed 
in Figure 10 on page 28. A message appears at the bottom of the screen that 
indicating the file and whether any LPA's were updated. 

During commit processing, the program will also automatically propagate the new 
data to all existing SeeBeyond Listener Program Areas (LPA's) in the same CICS 
region. There is one LPA for each instance of the SeeBeyond CICS Listener in the 
region. The STCCLSN (SeeBeyond CICS Listener) program uses its copy of the LPA 
to store monitoring statistics and to retrieve data used to control the execution of the 
SeeBeyond CICS Listener. Live updates to the LPAs provide the capability for real 
time control of the configuration flags and timers for all active SeeBeyond CICS 
Listeners executing at that time.
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Figure 10   

5 Continue making any necessary changes, committing them by pressing PF4. To exit 
the screen press PF3.
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2.7.1. The SeeBeyond CICS Listener Monitor Screen for z/OS
After the components are installed, use the SeeBeyond CICS Listener monitoring screen 
to verify that all components are properly installed and working correctly.

1 Logon to the CICS region that the SeeBeyond Listener is running in. Clear the 
screen, and type in stlm as displayed in Figure 11. Press Enter.

Figure 11   

2 The menu screen appears as displayed in Figure 12.

Figure 12   
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3 The pfkeys for this screen, and all of the monitor screens shown in this document, 
are as follows:

PF4: displays the LPAT (Listener Program Area Table).

PF13: displays the LPA counts and polling rates.

PF14: displays the LPA performance statistics.

PF15: displays the LPA last request header received from the CICS eWay.

PF16: displays the LPA last request payload received from the CICS eWay. 

PF17: displays the LPA last response header sent to the CICS eWay.

PF18: displays the LPA last response payload sent to the CICS eWay.

PF19: displays the LPA initial record sent from the IBM Listener (EZACIC02).

PF20: displays the LPA status.

PF21: displays the LPA last error message sent to the CICS eWay.

Press PF4. The Listener Program Area Table screen appears as displayed in Figure 
13.

Figure 13   

4 This screen displays the Listener Program Area Table (LPAT). Each line contains 
information about a Listener Program Area (LPA). There is one LPA associated with 
each instance of the SeeBeyond CICS Listener Program that is running or has run in 
this CICS region. The fields on the screen are:

CLPAT-status-flag: shows the current status of the LPAT entry as follows:

E: Exists.

N: Never used.
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C: Corrupted.

CLPAT-lpa-pointer: shows the address of the most recent LPA in this entry.

Listener Program Status: shows the last status of the Listener Program using
this LPA.

Press PF13. The LPA Counts and Polling Rates screen appears as displayed in 
Figure 14.

Figure 14   

5 This screen displays counts and polling rates information for each LPA. Each line 
shows one LPA (one for each instance of the SeeBeyond Listener Program).

The fields on the screen are as follows:

program link: the number of program links that have been requested.

start trans: the number of transaction starts that have been requested.

avg poll rate: the average number of receives per polling cycle to satisfy a full 
message receive from the CICS eWay.

non-max cnt: the 'high water mark' of receives within a polling cycle without 
reaching the polling rate (polling rate is sent in from the CICS eWay when it 
initializes connection with the CICS Listener program).

highest poll: the 'high water mark' of receives within a polling cycle that can 
include reaching the maximum allowed polling rate.

receive delay cnt: the number of one second delays that occurred due to the 
Comm Timeout limit being reached (Comm. Timeout is sent in from the CICS 
eWay when it initializes connection with the CICS Listener program).
CICS eWay Intelligent Adapter User’s Guide 31 SeeBeyond Proprietary and Confidential



Chapter 2 Section 2.7
Installing the CICS eWay SeeBeyond CICS Listener Configuration Maintenance for z/OS
listener delay cnt: number of one second delays that occur due to the Listener 
Timeout limit being reached (Listener Timeout is sent in from the CICS eWay 
when it initializes connection with the CICS Listener program). 

Press PF14. The LPA Performance Statistics screen appears as displayed in Figure 
15.

Figure 15   

6 This screen (Figure 15) displays the performance statistics for each LPA. Each line 
shows one LPA (one for each instance of the SeeBeyond Listener Program).

All times shown are in sss.mmm format (sss = seconds, mmm=milliseconds). The 
fields on the screen are as follows:

peek request: the average time spent peeking for the next incoming application 
request message.

receive request: the average time spent receiving the next incoming application 
request message.

send ack: the average time spent sending an ack for an incoming application 
request message.

link program: the average time spent link to requested application programs.

start tran: the average time spent starting requested application transactions.

send response: the average time spent sending the application response 
(including the updated COMMAREA for program links) back to the eWay.

peek ack: the average time spent peeking for the incoming ack to the preceding 
send response.

receive ack: the average time spent receiving the incoming ack to the preceding 
send response.
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Press PF15. The Last Application Request Header Received screen appears as 
displayed in Figure 16.

Figure 16   

7 This screen (Figure 16) displays the last application request header received from 
the CICS eWay for each LPA. Each line shows one LPA (one for each instance of the 
SeeBeyond Listener Program). The fields on the screen are as follows:

message length: the entire length of the incoming message including the header 
and payload.

program or tran: the requested application program or transaction.

appl timeout: (reserved for future development).

request code: which action is being requested.

0010 = link to application program.

0020 = start application transaction.

0111 = ack for a link response.

0121 = ack for a start response.

9000 = shutdown the Listener program.

response code: always set to zero from the CICS eWay.

pad char: padding character for the COMMAREA if the payload length is less 
than the COMMAREA length.

commarea length: the length of the data to pass to the application program 
(link) or the application transaction (start).

payload length: the length of the payload portion of the incoming message.
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Press PF16. The Last Application Request Payload Received screen appears as 
displayed in Figure 17.

Figure 17   

8 This screen (Figure 17) displays the last application request payload received from 
the CICS eWay for each LPA. Each line shows one LPA (one for each instance of the 
SeeBeyond Listener Program). There is one field on the screen:

Payload Received: the incoming payload from the CICS eWay.

Press PF17. The Last Application Response Header screen appears as displayed in 
Figure 18.
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Figure 18   

9 The Last Application Response Header screen (Figure 18 on page 35) displays the 
last response header sent to the CICS eWay for each LPA. Each line shows one LPA 
(one for each instance of the SeeBeyond Listener Program). The fields on the screen 
are as follows:

message length: the entire length of the outgoing message including the header 
and payload.

program or tran: the application program or transaction that was executed or 
started.

appl timeout: (reserved for future development).

request code: what action is being requested.

0001 = ack the init request.

0011 = ack for a link program request.   

0021 = ack for a start trans response.

0110 = response from a linked application program (including 
COMMAREA).

0120 = response from starting an application transaction (no COMMAREA 
included).

9001 = ack for a shutdown request.

response code: response code indicating what occurred while processing the 
previous incoming request from the eWay.

0000 = ok.

0011 = bad startcode during initialization. 
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0012 = bad password on init record.

0013 = bad comm timeout on init record.

0014 = bad appl timeout on init record. 

0015 = bad Listener timeout on init record.

0016 = error reading the init record from transient data queue.

0017 = error retrieving the init record from the start data.

0018 = error while setting blocking mode.

0051 = bad payload length. 

0052 = error while linking to a program.

0053 = error while starting a transaction.

0054 = bad request code.

0055 = bad response code.

0056 = partial message received.

0057 = bad program name.

0058 = bad message length.

0059 = bad commarea length.

pad char: padding char that was sent in from the CICS eWay.

commarea length: COMMAREA length that was sent in from the CICS eWay.

payload length: payload length that was sent in from the CICS eWay (the 
Listener sets this to zero if this is a response to a start transaction request).

Press PF18. The Last Application Response Payload Sent screen appears as 
displayed in Figure 19.
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Figure 19   

10 This screen (Figure 19) displays the last application response payload sent to the 
CICS eWay for each LPA. Each line shows one LPA (one for each instance of the 
SeeBeyond Listener Program). There is one field on the screen:

Payload sent: the outgoing payload being sent to the CICS eWay.

Press PF19. The Initialization Record Passed from EZACIC02 screen appears as 
displayed in Figure 20 on page 38.
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Figure 20   

11 This screen (Figure 20) displays the init record that was passed to the SeeBeyond 
Listener program from the IBM Listener program (ezacic02) for each LPA. Each line 
shows one LPA (one for each instance of the SeeBeyond Listener program). The 
fields on the screen are as follows:

sckt nbr: the socket number that is passed to the SeeBeyond Listener.

Listener applid: the applid of the CICS region that the IBM Listener is executing 
in that started this instance of the SeeBeyond Listener.

Listener tasked: the CICS taskid for the IBM Listener program that started this 
instance of the SeeBeyond Listener.

userid: userid passed in from the CICS eWay.

password: user password passed in from the CICS eWay.

comm. Timeout: this timeout value is the threshold limit for waiting for all the 
bytes of an incoming message.

Listener timeout: this timeout value is the threshold limit for waiting for a new 
incoming message.

poll rate: how many times the SeeBeyond Listener will perform a receive loop 
to satisfy a complete message receive, after which it will wait one second before 
trying again.

socket family: the TCP/IP family to which this socket belongs.

socket port: the port this instance of the SeeBeyond Listener is using.

Press PF20. The Status Code Information screen appears as displayed in Figure 21 
on page 39.
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Figure 21   

12 This screen (Figure 21) shows the status information for each LPA. Each line shows 
one LPA (one for each instance of the SeeBeyond Listener program). The fields on 
the screen are as follows:

Current status: the current status of an active SeeBeyond Listener program, or 
the last known status of a previously executing SeeBeyond Listener program.

C = LPA is initialized.

E = about to get ezacic02 data.

G = about to take socket from IBM Listener program.

I = about to set mode to blocking.

K = about to send ack for init request.

M = peeking for length of next incoming request.

O = peeking for entire incoming request.

Q = receiving full incoming request message.

S = sending ack for application request.

U = linking to requested application program.

W = starting a request application transaction.

Y = sending a application response.

0 = peeking for application response ack.

2 = receiving an application response ack.

4 = a shutdown request has been received.

6 = sending an ack for the shutdown request.
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7 = shutdown is complete, this LPA is now available for reuse.

8 = SeeBeyond Listener program appended.

Current Status date: date for this status.

Current Status time: time for this status.

Initial Startup date: date this instance of the SeeBeyond Listener was started.

Initial Startup time: time this instance of the SeeBeyond Listener was started.

cics task nbr: the CICS eibtaskn for this instance of the SeeBeyond Listener.

Press PF21. The Error Message Sent screen appears as displayed in Figure 22.

Figure 22   

13 This screen (Figure 22) shows the last error message sent to the CICS eWay for each 
LPA. Each line shows one LPA (one for each instance of the SeeBeyond Listener 
program). There is one field on the screen:

Error Message Sent: the last error message sent to the CICS eWay for this instance 
of the SeeBeyond Listener program. 

2.8 CICS Listener Considerations for Invoking DB2 
Applications

One of the following two techniques are required when using the CICS eWay to run 
CICS applications that invoke a DB2 table:

RCT entry for the STCL SeeBeyond CICS Listener Transaction

PPT entry to redirect DB2 application to another AOR
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RCT entry for the STCL SeeBeyond CICS Listener Transaction

To run DB2 application programs under the STCL SeeBeyond CICS Listener transid, an 
RCT entry for the STCL transaction must be created using an RCT macro definition 
similar to the one shown below or by using an equivalent RDO entry.

DSNCRCT TYPE=ENTRY,TXID=STCL,THRDM=0,THRDA=0,THRDS=0, 
TWAIT=POOL,PLAN=HD45LE06,AUTH=(SIGNID,*,*)         

PPT entry to redirect DB2 application to another AOR 

To redirect DB2 application programs to another AOR, the PPT entry for the requested 
DB2 application program in the TOR (where the STCL SeeBeyond CICS Listener 
transaction is running) must be defined to run the DB2 application program in a 
different region (usually an AOR) and under a specific PCT in that AOR. Refer to 
Figure 23 for a detailed flow diagram showing the use of the PPT and PCT.

Figure 23   SeeBeyond CICS Listener invoking DB2 programs
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2.9 CICS Transaction Gateway 5.1 Installation and 
Configuration 

For installation and configuration information regarding IBM’s CICS Transaction 
Gateway 5.1, consult the latest CTG 5.1 documentation at IBM’s CICS Library Website:

http://www-3.ibm.com/software/ts/cics/library/cicstgv5.html

This documentation should also be consulted for information on configuring CTG for 
use with RACF and the latest APARs.

IBM CICS Transaction Gateway properties are set using the CTG Configuration Tool. 
The Configuration Tool is located under the CICS Transaction Gateway program menu. 
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Chapter 3

Configuring the CICS eWay 

This chapter describes how to create and configure the CICS eWay properties.

What’s in This Chapter

Creating and Configuring the CICS eWay on page 43

Using the Properties Sheet on page 45

CICS eWay Connectivity Map Configuration Properties on page 46

CICS eWay Environment Explorer Configuration Properties on page 53

3.1 Creating and Configuring the CICS eWay
All eWays contain a set of parameters with properties unique to that eWay type. After 
the eWays are established and a CICS External System is created in the project’s 
Environment, the eWay parameters can be modified for your specific system. The CICS 
eWay parameters are modified from these locations:

From the Connectivity Map. These parameters most commonly apply to a specific 
component eWay, and may vary from other eWays (of the same type) in the project.

From the Environment Explorer tree. These parameters are commonly global, 
applying to all eWays (of the same type) in the project. The saved properties are 
shared by all eWays in the CICS External System window.

CICS eWay properties may also be set from the Collaboration Editor (Java) or 
eInsight Business Rules Designer, in which case they will override the 
corresponding properties in the eWay’s configuration file. Any properties that are 
not overridden retain their saved settings. Thieves

3.1.1 Selecting CICS as the External Application
To create a CICS eWay you must first create a CICS External Application in your 
Connectivity Map. CICS eWays are located between a CICS External Application and a 
Service. Services are containers for Collaborations, Business Processes, eTL processes, 
and so forth.

To create the CICS External Application

1 From the Connectivity Map toolbar, click the External Applications icon. 
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2 Select the CICS External Application from the menu (see Figure 24 on page 44). 
The selected CICS External Application icon appears on the Connectivity Map 
toolbar.

Figure 24   External Applications Selection Menu

3 Drag the new CICS External Application from the toolbar onto the Connectivity 
Map canvas. This represents an external CICS system.

From the Connectivity Map, you can associate (bind) the External Application with the 
Service to establish an eWay (see Figure 25).

Figure 25   eWay Location. 

When CICS is selected as the External Application, it automatically applies the default 
CICS eWay properties, provided by the OTD, to the eWay that connects it to the Service. 
These properties can then be or modified for your specific system using the Properties 
Sheet.

3.1.2 Modifying the CICS eWay Properties
A project’s eWay properties can be modified after the eWays have been established in 
the Connectivity Map and the Environment has been created.

Modifying the CICS eWay (Connectivity Map) Properties

1 From the Connectivity Map, double click the eWay icon, located in the link between 
the associated External Application and the Service. 

2 The eWay Properties Sheet opens with the CICS eWay Connectivity Map 
properties. Make any necessary modifications and click OK to save the settings.

Modifying the CICS eWay (Environment Explorer) Properties

1 From the Environment Explorer tree, right-click the CICS External System. Select 
Properties from the shortcut menu. The Properties Sheet opens with the CICS 
eWay Environment properties.

2 Make any necessary modifications to the Environment properties of the CICS 
eWays, and click OK to save the settings.

CICS
eWay
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3.1.3. Using the Properties Sheet 
Modifications to the eWay configuration properties are made from the CICS eWay 
Properties Sheet. 

To modify the default eWay configuration properties

1 Open the Properties Sheet to the CICS eWay default properties. An eWay has two 
different sets of parameters: those specific to that particular eWay (accessed from 
the Connectivity Map), and those that are common to all eWays of this type 
(accessed from the Environment Explorer tree). 

2 From the upper-right pane of the Properties Sheet, select a subdirectory of the 
configuration directory. The parameters contained in that subdirectory are now 
displayed in the Properties pane of the Properties Sheet. For example, clicking on 
the connector subdirectory displays the editable parameters in the right pane, as 
shown in Figure 26.

Figure 26   Properties Sheet -- CICS Properties

3 Click on any property field to make it editable. For example, click on the class 
parameter to edit the class value. If a parameter’s value is true/false or multiple 
choice, the field reveals a submenu of property options. 
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Click on the ellipsis (. . .) in the properties field to open a separate configuration 
dialog box. This is helpful for large values that cannot be fully displayed in the 
parameter’s property field. Enter the property value in the dialog box and click OK. 
The value is now displayed in the parameter’s property field.

4 A description of each parameter is displayed in the Description pane when that 
parameter is selected, providing an explanation of any required settings or options.

5 The Comments pane provides an area for recording notes and information 
regarding the currently selected parameter. This is saved for future referral.

6 After modifying the configuration properties, click OK to close the Properties Sheet 
and save the changes.

3.2 CICS eWay Connectivity Map Configuration Properties
The CICS eWay configuration parameters, accessed from the Connectivity Map, are 
organized into the following sections:

Connection Establishment and Retry on page 46

Connector on page 48

CICS Client on page 50

3.2.1. Connection Establishment and Retry
The Connection Establishment and Retry section contains the top level parameters 
displayed in Figure 27.

Figure 27   Properties Editor - Connectivity Map, Connection Establishment and Retry
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Maximum Retries

Description

Specifies the maximum number of connection retries.

Required Value

A number indicating the number of times the eWay tries to establish a connection. The 
configured default is 5.

Retry Interval [ms]

Description

Specifies the number of milliseconds to wait between connection retries. 

Required Value

A number indicating the time (in milliseconds) that the eWay waits between connection 
attempts. The configured default is 5000 (or 5 seconds).
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3.2.2. Connector
The Connector section contains the top level parameters displayed in Figure 27.

Figure 28   Properties Editor - Connectivity Map, Connector Properties

Class

Description

Specifies the class name of the CICS Client connector object.

Required Value

The (class) package name for the CICS Client connector object. The default is 
com.stc.eways.cics.CicsClientConnector.

Connection Transport

Description

Specifies the underlying connection transport used by the CICS eWay to send requests 
and get responses from a CICS region. 

Required Value

Enter the name of the selected underlying connection transport as follows:

SeeBeyond CICS Listener 

Transaction Gateway (specifies the IBM CICS Transaction Gateway)

Transaction Gateway is the configured default.
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Property.Tag

Description

Specifies the data source identity. This parameter is required by the current 
EBobConnectorFactory.

Required Value

The data source package name. 

Type

Description

Specifies the connector type.

Required Value

CICS. The value always defaults to CICS for CICS connections.
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3.2.3. CICS Client
The CICS Client section contains the top level parameters displayed in Figure 29.

Figure 29   Properties Editor - Connectivity Map, CICS Client Properties

CICS Program

Description

Specifies the CICS program to be run on the server. Maximum length is eight 
characters.

Required Value

A CICS program name, eight characters or less.

CICS TransId

Description

Specifies the CICS TransId to be run on the server. Maximum length is four characters.

Required Value

A CICS TransId of four characters or less.
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COMMAREA Length

Description

Specifies the length (in bytes) of the COMMAREA passed to the ECI.

Required Value

A number indication the byte length of the COMMAREA. 

Note: When using the CICS Transaction Gateway transport, data sent to CICS must be 
padded with spaces, if necessary, to match the full size of the commarea.

ECI call type

Description

Specifies whether the ECI call type is Synchronous. Synchronous calls wait for the 
transaction to complete, then return the contents of the COMMAREA. Only 
Synchronous calls are supported

Required Value

Synchronous is the configured default.

ECI extend mode

Description

Specifies whether a logical unit of work is terminated at the end of a call. 

Required Value

Yes or No. Yes indicates that the work unit is terminated at the end of a call. No is the 
configured default.

ECI LUW Token

Description

CTG specific. Specifies the logical unit of work to which a call belongs. This must be set 
to zero at the start of a logical work unit. The ECI updates the value on the first (or only) 
call of the logical work unit. If the unit of work is to be extended, this value will be used 
as input to all subsequent calls associated with the same logical work unit.

If the return code is not ECI_NO_ERROR and a call is ending or continuing an existing 
logical work unit, then this field is used to report the state of the logical work unit. If it 
is zero, the logical work unit has ended and updates have been backed out. If it is not 
zero, the value is the same as the input value. The logical work unit is continuing, and 
updates are still pending.

Required Value

A number indicating the ECI logical unit of work. 
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Encoding

Description

Specifies the canonical name for the encoding set.

Required Value

The canonical name for any encoding set supported by Sun's Java Runtime 
Environment 1.1.8 (contained in rt.jar and i18n.jar). Examples are ASCII and Cp500 
(EBCDIC). When running the CICS eWay on a z/OS platform, set the Encoding value to 
ISO-8859-1.

Message Qualifier

Description

CTG specific. The ECI Message Qualifier identifies each asynchronous call if more than 
one call is made. This security feature-related ID is only used on the same JavaGateway 
that created or assigned them.

Required Value

A number indicating the asynchronous call’s ECI Message Qualifier. 
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3.3 CICS eWay Environment Explorer Configuration 
Properties

The CICS eWay configuration parameters, accessed from the Environment Explorer 
tree, are organized into the following sections:

SeeBeyond CICS Listener on page 53

CICS Gateway on page 57

Tracing on page 59

CICS Client on page 61

3.3.1. SeeBeyond CICS Listener
The SeeBeyond CICS Listener section contains the parameters displayed in Figure 30.

Figure 30   Properties Editor - Environment, SeeBeyond CICS Listener Properties

COMMAREA Padding Character

Description

Specifies the EBCDIC code for the character used by the SBYND listener to pad the 
COMMAREA at the CICS server when the actual length of the payload in the COMMAREA is 
shorter than the length given by CommAreaLength. The default value is hexadecimal 40 - 
EBCDIC space.

Required Value

A character value coded in Hexadecimal. For example: 40 for Blanks, 00 for Low 
Values, FF for High Values, and so forth. The default value is 40.
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Host

Description

Specifies the name of the mainframe host with which to connect. This is always CICS.

Required Value

CICS. The value always defaults to CICS for CICS connections. The default is CICS.

KeepAlive

Description

Specifies whether to enable socket keep-alive checking. A setting of TRUE enables an 
implementation specific time period when a probe is sent to the peer host. The purpose 
of this option is to detect if the peer host has crashed.

One of three responses is expected:

1 The peer responds with the expected ACK. The application is not notified (since 
everything is OK). TCP will send another probe following another 2 hours of 
inactivity. 

2 The peer responds with an RST, which tells the local TCP that the peer host has 
crashed and rebooted. The socket is closed. 

3 There is no response from the peer. The socket is closed. 

Required Value

Enter TRUE or FALSE. TRUE is the default.

Listener Timeout

Description

Specifies the estimated amount of time (in milliseconds) for the SeeBeyond CICS 
Listener to wait for the next incoming transaction program request from the CICS eWay.

Required Value

An integer between 1 and 864000 representing milliseconds (for example, 120000 
milliseconds equals 2 minutes). The default value is 5000.

NoDelay

Description

Specifies whether the system can delay connections or requests. Generally, NoDelay/
True is necessary for high-volume and/or critical transactions. In cases of low-volume 
and/or noncritical transactions, you can use NoDelay/False. Required Values

Required Value

Enter TRUE or FALSE. TRUE is the default.
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Polling Rate

Description

Specifies the polling rate. This is the number of times the SeeBeyond CICS Listener will 
query the current TCP connection for incoming traffic before issuing an EXEC CICS 
DELAY for one second.

Required Value

An integer between 1 and 255 representing. 

Port

Description

Specifies the TCP/IP port where the SeeBeyond CICS Listener is listening. This is the 
port to which the CICS eWay will connect.

Required Value

The TCP/IP port to which SeeBeyond CICS Listener is listening. 

ReceiveBufSize

Description

Specifies the Receive Buffer Size (in bytes) for the underlying socket, this is a hint.

Required Value

An integer between 1 and 864000 representing bytes (for example, 10240 bytes equals 
10 kilobytes). 

SeeBeyond CICS Listener TransId

Description

Specifies the TransId of the SeeBeyond CICS Listener on the mainframe host. This is the 
CICS Transaction that the SeeBeyond CICS Listener is installed under.

Required Value

The valid TransId of the SeeBeyond CICS Listener. The default is STCL.

SendBufSize

Description

Specifies the Send Buffer Size for the underlying socket.

Required Value

An integer between 1 and 864000 representing bytes (for example, 10240 bytes equals 
10 kilobytes).
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Start Delay

Description

Specifies the hours, minutes and seconds (interval of time) to delay starting the 
transaction program (TP) on the CICS server for the IC Start Type. This field is optional 
but must specify all 6 digits if used. 

Required Value

A 6 digit integer. All 6 digits must be given if this is specified (for example, 123456). The 
default value is 000000.

Start Type

Description

Specifies the startup type. This can be either IC for CICS interval control or TD for CICS 
transient data. This is the CICS Startup type for the program being executed.

Required Value

Select IC or TD. The default value is IC.

TP Timeout

Description

Specifies the amount of time the CICS eWay will wait for the SeeBeyond CICS Listener 
to return results for a current transaction program request.

Required Value

An integer between 1 and 864000 representing milliseconds (for example, 120000 
milliseconds equals 2 minutes). 

Transport Timeout

Description

Specifies the timeout used by both the local and host side for receive on the socket.

Required Value

An integer between 1 and 864000 representing milliseconds (for example, 120000 
milliseconds equals 2 minutes). 
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3.3.2. CICS Gateway
These parameters are specific to the CICS Transaction Gateway (CTG). This section 
contains the top level parameters displayed in Figure 31.

Figure 31   Properties Editor - Environment, CICS Gateway Properties

Port

Description

Specifies the TCP/IP port with which to connect, that is, the port where CTG is 
running.

Required Value

An number indicating the TCP/IP port. 

SSL KeyRing Class

Description

Specifies the full classname of the SSL KeyRing class.

Required Value

The full classname of the SSL KeyRing class.
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SSL KeyRing Password

Description

Specifies the password for the encrypted KeyRing class.

Required Value

The password for the SSL KeyRing class.

URL

Description

Specifies the remote or local Gateway with which to connect. 

Required Value

The remote or local Gateway node name or IP address.

Additional Information 

This parameter requires specific JAR files when using local: as the value. For directions 
on installing the required files, see Adding JAR Files to the LogicalHost on page 62

The default value, local:, does not work with CTG running on z/OS. For CTG running 
on a z/OS system, the URL property value must be set to localhost or to the server 
name.
CICS eWay Intelligent Adapter User’s Guide 58 SeeBeyond Proprietary and Confidential



Chapter 3 Section 3.3
Configuring the CICS eWay CICS eWay Environment Explorer Configuration Properties
3.3.3. Tracing
This section contains the top level parameters displayed in Figure 32.

Figure 32   Properties Editor - Environment, Tracing Properties

Dump Offset

Description

CTG specific. Specifies the offset from which the display of any data blocks will start. 

Required Values

A number indicating the offset. If the offset is greater than the total length of data to be 
displayed, an offset of 0 is used. 

The dump offset can also be set using the system property 
gateway.T.setDumpOffset=xxx, where xxx is a number.

Filename

Description

CTG specific. Specifies a file location for writing the trace output. This is an alternative 
to the default output on stderr. Long filenames must be surrounded by quotation 
marks; for example: "trace output file.log". 

Required Values

The output file name.

The filename can also be set using the system property gateway.T.setTFile=xxx, where 
xxx is a filename.
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Level

Description

CTG specific. Specifies the level of trace information available. 

Required Values

An integer in the range of 0 to 3, indicating the following:

0: None. No CICS Java client application tracing.

1: Standard. Only the first 128 bytes of any data block (for example the 
COMMAREA, or network flows) are displayed by default. This trace level is 
equivalent to the Gateway trace set by the ctgstart -trace option. (This can also be set 
using the system property gateway.T.trace=on)

2: Full Debug. Traces out the whole of any data blocks by default. The trace 
contains more information about CICS Transaction Gateway than the standard trace 
level. This trace level is equivalent to the Gateway debug trace set by the ctgstart -x 
option. (This can also set using the system property gateway.T=on)

3: Exception Stacks. Traces most Java exceptions, including exception which are 
expected during normal operation of the CICS Transaction Gateway. No other 
tracing is written. This trace level is equivalent to the Gateway stack trace set by the 
ctgstart -stack option. (This can also set using the system property 
gateway.T.stack=on)

Timing

Description 

Specifies whether or not to display time-stamps in the trace. 

Required Value

On or Off. On indicates that the time-stamp is displayed in the trace. The default 
setting is On.

Timing can also set using the system property gateway.T.timing=on.

Truncation Size

Description 

CTG specific. Specifies the maximum size of any data blocks written in the trace. 

Required Value

A number indicating the maximum data block size. A value of 0 indicates that no data 
blocks will be written in the trace. No value (leaving the property blank) indicates that 
no truncation size is specified. 

The truncation size can also be set using the system property 
gateway.T.setTruncationSize=xxx, where xxx is a number.
CICS eWay Intelligent Adapter User’s Guide 60 SeeBeyond Proprietary and Confidential



Chapter 3 Section 3.3
Configuring the CICS eWay CICS eWay Environment Explorer Configuration Properties
3.3.4. CICS Client
This section contains the top level parameters displayed in Figure 33.

Figure 33   Properties Editor - Environment, CICS Client Properties

CICS Password

Description

Specifies the password for the CICS user. Maximum length is eight characters.

Required Value

A password, eight characters or less, for the user ID.

CICS UserId

Description 

Specifies the ID of the CICS user. Maximum length is eight characters.

Required Value

A CICS user ID, eight characters or less. 
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3.4 Adding JAR Files to the LogicalHost
When using local: as a URL value in the Environment properties, both the ctgclient.jar 
and the ctgserver.jar files must be installed to the following location prior to running a 
CICS eWay project. 

<ican50>\logicalhost\stcis\lib

where <ican50> is the directory ICAN is installed.

The JAR files can be added from the Enterprise Designer manually, or by using the 
Upload Files option. The Upload Files option automatically ensures that the Logical 
Host will reload the files if it is rebuilt. Do not remove the location of the JAR file (since 
the repository remembers its location). 

To add the required JAR files using the Upload Files option, do the following:

1 From the Environment Explorer tree, right click the Logical Host and select Upload 
File from the shortcut menu. The Upload Third Party Files dialog box appears.

2 From the Upload Third Party Files dialog box, click Add, browse to and select the 
appropriate JAR files, and click Open. 

3 Click OK to close the dialog box.

4 Right click the Logical Host and select Apply from the menu.

Note: If the Logical Host is running, it must be recycled to pickup the new Jar file.

3.5 Alerting and Logging
eGate provides an alerting and logging feature. This allows monitoring of 
messages, and captures any adverse messages in order of severity based on 
configured severity level and higher. 

For information on enabling or modifying the level of logging for the various 
logging categories, see the eGate Integrator System Administration Guide.

The alerts/status notifications for the CICS eWay are currently limited to Started, Running, 
Stopping, and Stopped. 
CICS eWay Intelligent Adapter User’s Guide 62 SeeBeyond Proprietary and Confidential



Chapter 4

Using eInsight Business Processes with the 
CICS eWay

This chapter describes how to use the CICS eWay with the ICAN Suite’s eInsight 
Business Process Manager and the Web Services interface.

Note: You must have the eInsight.sar file installed to use the Web Services interface.

What’s in This Chapter

The eInsight Engine and Components on page 63

The CICS eWay With eInsight on page 64

The CICS eWay eInsight Sample Project on page 64

4.1 The eInsight Engine and Components
eGate components can be deployed as Activities in eInsight Business Processes. Once a 
component is associated with an Activity, eInsight invokes it using a Web Services 
interface. eGate components that can interface with eInsight in this way include the 
following:

Object Type Definitions (OTDs)

eWays

Collaborations

Using the Enterprise Designer and eInsight, you can add an Activity to a Business 
Process, then associate that Activity with an eGate component, for example, an eWay. 
Then, when eInsight runs the Business Process, it automatically invokes that 
component via its Web Services interface.

See the eInsight Business Process Manager User’s Guide for details.
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4.2 The CICS eWay With eInsight
An eInsight Business Process Activity can be associated with the CICS eWay during the 
system design phase. To make this association, select the desired operators under the 
eWay in the Enterprise Explorer and drag it onto the eInsight Business Process Designer 
canvas. 

The CICS eWay has the following operators available:

execute

The operation is automatically changed to an Activity with an icon identifying the 
component that is the basis for the Activity. At run time, eInsight invokes each step in 
the order defined in the Business Process. Using eInsight’s Web Services interface, the 
Activity in turn invokes the CICS eWay. 

Dynamic Configuration 

The CICS eWay web service message structure exposes properties such as server, 
transId, password, userId, and so forth, that correspond to eWay configuration 
parameters. Populating these properties dynamically at runtime from the Business 
Rules Designer, allows the user to override the corresponding configuration 
parameters.

4.3 The CICS eWay eInsight Sample Project
This following pages provide directions for creating a simple project that demonstrates 
how eInsight Business Processes are used with the CICS eWay. The same project can be 
downloaded from the Installation CD-ROM in a near-complete state.

For more information on creating ICAN projects see the eInsight Business Process 
Manager User’s Guide and the eGate Integrator User’s Guide. 

Expanded BPEL Properties

The 5.0.3 version of the CICS eWay displays additional CICS BPEL properties in the 
message structure, visible from the Business Rules Designer. The packaged sample that 
is included on the installation CD-ROM is designed to work with eGate, versions 5.0.1 
and above, and will not display these additional properties when loaded. To see these 
additional parameters, create the sample manually, as directed in this chapter.

4.4 Importing a Sample Project
Sample eWay projects are included as part of the installation CD-ROM package. To 
import a sample eWay project to the Enterprise Designer do the following:

1 The sample files are uploaded with the eWay’s documentation .sar file and 
downloaded from the Enterprise Manager’s Documentation tab. The 
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CICS_eWay_Sample.zip file contains the various sample project zip files. Extract 
the samples from the Enterprise Manager to a local file.

2 Save all unsaved work before importing a project.

3 From the Enterprise Designer’s Project Explorer pane, right-click the Repository 
and select Import from the shortcut menu. The Import Manager appears.

4 Browse to the directory that contains the sample project zip file. Select the sample 
file (for this sample, CICS_BP_Sample.zip) and click Import. After the sample 
project is successfully imported, click Close. 

5 Before the imported sample project can be run you must do the following:

Create an Environment (see Creating an Environment on page 73)

Configure the eWay properties for your specific system (see Configuring the 
eWay Properties on page 74)

Create a Deployment Profile (see Creating and Activating the Deployment 
Profile on page 76)

The following pages provide step by step directions for manually creating the 
CICS_BP_Sample project. 

4.5 The CICS_BP_Sample Project Overview
The CICS eWay project, CICS_BP_Sample, demonstrates the following:

The Inbound File eWay subscribes to an external directory and receives input data 
(ASCII text). 

The ASCII text data is converted to EBCDIC (byte array) using cp037 encoding, and 
published by the CICS eWay, to the CICS external system.

Input EBCDIC data from the CICS external system, is received by the CICS eWay 
and converted back to String ASCII data using cp037 encoding. This data is 
published to the outbound File eWay.

The outbound File eWay publishes the data to an external directory.

Figure 34   CICS_BP_Sample Project
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4.6 Creating the CICS_BP_Sample Project
The following pages provide step by step directions for creating the CICS_BP_Sample 
project.

4.6.1. Creating a Project
The first step is to create a new project in the SeeBeyond Enterprise Designer.

1 Start the Enterprise Designer.

2 From the Project Explorer tree, right-click the Repository and select New Project 
(see Figure 35). A new project (Project1) appears on the Project Explorer tree.

Figure 35   Enterprise Explorer - New Project

3 Click twice on Project1 and rename the project (for this sample, CICS_BP_Sample).

4.6.2 Creating a Business Process
To create the CICS eInsight Business Process, do the following:

Creating the Business Process Flow

1 Right-click an existing project (for this sample CICS_BP_Sample) in the Enterprise 
Designer’s Project Explorer, and select New > Business Process from the shortcut 
menu. The eInsight Business Process Designer appears and BusinessProcess1 is 
added to the Project Explorer tree. Rename BusinessProcess1 to CICS_BP.

2 From the Project Explorer tree, expand the SeeBeyond > eWays > CICSeWay > 
CICS_eWay, and File > FileClient nodes.

3 Populate the eInsight Business Process Designer’s modeling canvas with the 
following activities from the Project Explorer tree, as displayed in Figure 36 on 
page 67:

receive, under SeeBeyond > eWays > File > FileClient

execute, under SeeBeyond > eWays > CICSeWay > CICS_eWay 

write, under SeeBeyond > eWays > File > FileClient
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Figure 36   eInsight Business Process Designer - Populate the Canvas

4 Link the modeling elements by clicking on the element connector and dragging the 
cursor to the next element connector, making the following links as displayed in 
Figure 37.

Start -> FileClient.receive

FileClient.receive -> CICS_eWay.execute

CICS_eWay.execute -> FileClient.write

FileClient.write -> End

Figure 37   Business Process Designer - Link the Modeling Elements
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Configuring the Modeling Elements 

Business Rules, created between the Business Process Activities, allow you to configure 
the relationships between the input and output Attributes of the Activities using the 
Business Process Designer’s Business Rule Designer.

Adding Business Rules

1 Right-click the link between the FileClient.receive and CICS_eWay.execute 
Activities and select Add Business Rule from the shortcut menu. 

2 Repeat step 1 for the CICS_eWay.execute to FileClient.write link (see Figure 38).

Figure 38   eInsight Business Process Designer - Adding Business Rules

Using the Business Rule Designer

1 From the eInsight Business Process Designer toolbar, click the Display Business 
Rules Designer button. The Business Rule Designer appears at the bottom of the 
eInsight Business Process Designer.

2 Click on the Business Rule icon in the link between FileClient.receive and 
CICS_eWay.execute to display the Business Rule’s Input and Output Attributes in 
the Business Rule Designer. These Attributes can now be modified.

3 To create the FileClient.receive -> CICS_eWay.execute Business Rule do the 
following:

A From the Business Rule Designer String menu, select Settings. The Method 
Palette appears. From the String tab, select bytes to text and text to bytes, and 
click Close. The bytes to text and text to bytes options are added to the String 
menu.

B From the Business Rule Designer String menu, select text to bytes. The text to 
bytes method box appears on the Business Rule Designer canvas.

C From the Business Rule Designer String menu, select String Literal. The Input 
dialog box appears. Enter cp037 as the literal value. The string-literal method 
appears.

D Map text, under FileClient.receive.Output to the text input node of the text to 
bytes method box. To do this, click on text under FileClient.receive.Output in 
Output pane of the Business Rule Designer, and drag the cursor to the text input 
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node of the text to bytes method box. 

E Map return bytes in the text to bytes method box, to commArea under 
CICS_eWay.execute.Input > Input in the Input pane of the Business Rule 
Designer.

F Map the cp037 output node of the string literal method box, to the encoding 
input node of the text to bytes method box (see Figure 39). 

Figure 39   eInsight Business Rule Designer 

4 To create the CICS_eWay.execute -> FileClient.write Business Rule do the 
following: 

A Click on the Business Rule icon in the link between the CICS_eWay.execute and 
FileClient.write activities. This Business Rule Designer now displays the Input 
and Output attributes.

B From the Business Rule Designer String menu, select bytes to text. The bytes to 
text method box appears.

C From the Business Rule Designer String menu, select String Literal. The Input 
dialog box appears. Enter cp037 as the literal value. The string-literal method 
appears.

D Map commArea, under CICS_eWay.execute.Output > output in the Output 
pane, to the bytes input node of the bytes to text method box.

E Map the return text output node of the bytes to text method box, to text under 
FileClient.write.Input in the Input pane.

F Map the string-literal value, cp037, to the encoding input node of the bytes to 
text method box (see Figure 40 on page 70).
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Figure 40   eInsight Business Rule Designer

5 From the Business Process Designer toolbar, click Synchronize Graphical Model 
and Business Process icon to synchronize the graphical interface to the Business 
Process code.

6 Save your changes to the Repository.

4.6.3 Creating a Connectivity Map
The Connectivity Map provides a canvas for assembling and configuring a project’s 
components.

1 From the Project Explorer tree, right-click the new CICS_BP_Sample project and 
select New > Connectivity Map from the shortcut menu. 

2 The New Connectivity Map appears and a node for the Connectivity Map is added 
under the project on the Project Explorer tree labeled CMap1. Rename the 
Connectivity Map CICS_BP_Sample_CM.

The icons in the toolbar represent the available components used to populate the 
Connectivity Map canvas. 

Selecting the External Applications

In the Connectivity Map, the eWays are associated with External Systems. For example, 
to establish a connection to CICS, you must first select CICS as an External System to 
use in your Connectivity Map (see Figure 41). 

Figure 41   Connectivity Map - External Applications

1 Click the External Application icon on the Connectivity Map toolbar,
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2 Select the external systems necessary to create your project (for this sample, CICS 
and File). Icons representing the selected external systems are added to the 
Connectivity Map toolbar.

Populating the Connectivity Map

Add the project components to the Connectivity Map by dragging the icons from the 
toolbar to the canvas. 

1 For this sample, drag the following components onto the Connectivity Map canvas 
as displayed in Figure 42: 

File External System (2)

Service (A service is a container for Collaborations, Business Processes, eTL 
processes, and so forth)

CICS External System

Figure 42   Connectivity Map with Components

2 Rename the File1 External Application to FileIn by right-clicking the object, 
selecting Rename from the shortcut menu, and typing in the new name.

3 Rename the File2 External Application to FileOut.

4 Rename Service1 to CICS_BP_Service.

5 Save your current changes to the Repository.

4.6.4. Binding the eWay Components
After the Business Processes have been completed, the components are associated and 
Bindings are created in the Connectivity Map.

1 From the Project Explorer, double-click CICS_BP_Sample_CM. The Enterprise 
Designer canvas now displays the Connectivity Map.

2 Drag and drop the CICS_BP Business Process from the Project Explorer onto the 
Service (CICS_BP_Service). If the Business Process was successfully associated, the 
Service’s icon changes to a Business Process icon (see Figure 43).
CICS eWay Intelligent Adapter User’s Guide 71 SeeBeyond Proprietary and Confidential



Chapter 4 Section 4.6
Using eInsight Business Processes with the CICS eWay Creating the CICS_BP_Sample Project
Figure 43   Connectivity Map - Binding the eWay Components

3 Double-click CICS_BP_Service. The CICS_BP_Service Binding dialog box appears 
using the CICS_BP Rule.

4 From the CICS_BP_Service Binding dialog box, drag FileSender (under 
Implemented Services) to the FileIn (File) External Application.

5 From the CICS_BP_Service Binding dialog box, drag CICS_Receiver (under 
Invoked Services) to the CICS1 External Application. 

6 From the CICS_BP_Service Binding dialog box, drag FileReceiver to the FileOut 
External Application (see Figure 44). Minimize the CICS_BP_Service Binding dialog 
box by clicking the chevrons in the upper-right corner.

Figure 44   Connectivity Map - Associating (Binding) the Project’s Components

7 Minimize the CICS_BP_Service Binding dialog box by clicking the chevrons in the 
upper-right corner.

8 Save your current changes to the Repository.
CICS eWay Intelligent Adapter User’s Guide 72 SeeBeyond Proprietary and Confidential



Chapter 4 Section 4.6
Using eInsight Business Processes with the CICS eWay Creating the CICS_BP_Sample Project
4.6.5. Creating an Environment
Environments include the external systems, Logical Hosts, integration servers and 
message servers used by a project and contain the configuration information for these 
components. Environments are created using the Enterprise Designer’s Environment 
Explorer and Environment Editor.

1 From the Enterprise Designer’s Enterprise Explorer, click the Environment 
Explorer tab. 

2 Right-click the Repository and select New Environment. A new Environment is 
added to the Environment Explorer tree.

3 Rename the new Environment to CICS_BP_Sample_ENV.

4 Right-click CICS_BP_Sample_ENV and select New CICS External System. Name 
the External System CicsExtSys. Click OK. CicsExtSys is added to the Environment 
Editor. 

5 Right-click CICS_BP_Sample_ENV and select New File External System. Name 
the External System FileExtSysIn and select Inbound File eWay as the External 
System Type. Click OK. FileExtSysIn is added to the Environment Editor.

6 Right-click CICS_BP_Sample_ENV and select New File External System. Name 
this External System FileExtSysOut and select Outbound File eWay as the External 
System Type. FileExtSysOut is added to the Environment Editor.

7 Right-click CICS_BP_Sample_ENV and select New Logical Host. The 
LogicalHost1 box is added to the Environment and LogicalHost1 is added to the 
Environment Editor tree.

8 From the Environment Explorer tree, right-click LogicalHost1 and select New 
SeeBeyond Integration Server. A new Integration Server (IntegrationSvr1) is 
added to the Environment Explorer tree under LogicalHost1.

9 Save changes to the repository. The Environment Explorer and Environment Editor 
now appear as displayed in Figure 45.

Figure 45   Environment Editor
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4.6.6. Configuring the eWay Properties 
The CICS_BP_Sample project uses three eWays, each represented in the Connectivity 
Map as a node between an External Application and a Business Process. eWays 
facilitate communication and movement of data between the external applications and 
the eGate system. 

The File eWay properties are configured from the Connectivity Map. The CICS eWay 
configuration parameters are set from both the Project Explorer’s Connectivity Map 
and the Environment Explorer tree.

To configure the eWays do the following:

Configuring the File eWay Properties 

1 Double-click the inbound File eWay (see Figure 46), select Inbound File eWay in 
the Templates dialog box and click OK.

Figure 46   eWays

2 The Properties Sheet opens to the inbound File eWay properties. Modify the 
properties for your system, including the settings for the inbound File eWay in 
Table 3, and click OK.

Table 3   Inbound File eWay Settings

3 In the same way, modify the outbound File eWay properties for your system, 
including the settings in Table 4, and click OK.

Table 4   Outbound File eWay Settings

Inbound eWay Connection Parameters

Directory C:/temp

Input file name Input*.txt

Outbound eWay Connection Parameters

Directory C:/temp

Output file name output%.dat

Inbound File eWay Outbound File eWay

CICS eWay
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Configuring the CICS eWay Properties

The CICS eWay properties must be set in both the Project Explorer’s Connectivity Map 
and Environment Explorer. For more information on the CICS eWay properties and the 
Properties Sheet, see Creating and Configuring the CICS eWay on page 43 or see the 
eGate Integrator User’s Guide.

Modifying the CICS eWay Connectivity Map Properties 

1 From the Connectivity Map, double-click the CICS eWay. The Parameters dialog 
box opens to the CICS eWay project configuration properties.

2 Modify the CICS eWay Connectivity Map properties for your system, including the 
settings in Table 5, and click OK.

Table 5   CICS eWay Connectivity Map Properties

Modifying the CICS eWay Environment Explorer Properties 

1 From the Environment Explorer tree, right-click the CICS External System 
(CicsExtSys in this sample), and select Properties from the shortcut menu. The 
Properties Sheet appears.

2 Modify the CICS eWay environment properties for your system, including the 
settings in Table 6, and click OK.

Table 6   CICS Environment Explorer eWay Properties 

CICS eWay (Connectivity Map) Properties 

Connector 
Set as directed, otherwise use the default settings

Class com.stc.eways.cics.CicsClientConnector

Connection Transport SeeBeyond CICS Listener

Type CICS

CICS Client 
Set as directed, otherwise use the default settings.

COMMAREA Length 1000

CICS Program CICS program to be run on server

CICS eWay Environment Properties 

SeeBeyond CICS Listener Settings 
Set as directed, otherwise use the default settings

Host Host Name

Port TCP/IP Port Number

CICS Client Settings
Set as directed, otherwise use the default settings.

CICS Password Password of CICS user

CICS UserId This is the Id of the CICS user
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Note: CICS eWay properties may also be set from the Collaboration Editor (Java) or 
eInsight Business Rules Designer, in which case they will override the 
corresponding properties in the eWay’s configuration file. Any properties that are 
not overridden retain their saved settings.

4.6.7 Creating and Activating the Deployment Profile
Deployment Profiles are specific instances of a project in a particular Environment. A 
Deployment Profile contains information about the assignment of Services and 
message destinations to integration and message servers (JMS IQ Managers). It also 
contains version information for all versionable objects in the project. Deployment 
profiles are created using the Deployment Editor.

To create the CICS_BP_Sample Deployment Profile do the following:

1 From the Enterprise Explorer’s Project Explorer, right-click the project 
(CICS_BP_Sample) and select New > Deployment Profile from the shortcut menu. 

2 Enter a name for the Deployment Profile (for this sample CICS_BP_Sample_DP). 
Make sure that the selected Environment is CICS_BP_Sample_ENV. Click OK. The 
Deployment Profile Editor appears.

3 Click the Auto Map icon as displayed in Figure 47. The projects components are 
automatically mapped to their system window as seen in Figure 48 on page 77. If 
any of the project components are not mapped automatically after Auto Map is 
used, those component can be mapped manually by following the appropriate steps 
below. Once all components are mapped, proceed to step 9.

Figure 47   Deployment Profile - Auto Map

4 From the left pane of the Deployment Editor, drag the FileIn -> CICS_BP_Service 
(external application) object to the FileExtSysIn window.

5 Drag the CICS_BP_Service -> FileOut (external application) object to the 
FileExtSysOut window.

6 Drag the CICS_BP_Service -> CICS1 (external application) to the CicsExtSys 
window.
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7 Drag the CICS_BP_Service object to IntegrationSvr1 in the Logicalhost1 window 
(see Figure 48).

Figure 48   Deployment Profile

8 Click Activate. When activation succeeds, save the changes to the Repository.

4.6.8. Running the Project
The following directions assume that the Enterprise Designer was downloaded to 
C:\ican50. If this is not the case, replace that location in the following directions with 
the appropriate location.

1 From the Enterprise Manager Downloads tab, download Logical Host - for win32.

2 Extract the file to the ican50\logicalhost1\logicalhost directory. You must specify 
the logicalhost1 directory for it to be created.

3 Navigate to C:\ican50\logicalhost1\logicalhost\bootstrap\config directory and 
open the logical-host.properties file using Notepad™.

4 Enter the following information in the appropriate fields:

Logical Host root directory: ican50\logicalhost1\logicalhost

Repository URL: http://localhost:port number/repository name

Repository user name and password: Your user name and password

Logical Host Environment name: CICS_BP_Sample_Env

Logical Host name: logicalhost1

Save your changes to logical-host.properties and close the file.

5 Run the bootstrap.bat file in the eGate50\logicalhost1\logicalhost\bootstrap\bin 
directory.

6 Copy the sample input data file to the input directory.
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Chapter 5

Implementing a CICS eWay Project

This chapter provides an introduction to the CICS eWay components and information 
on how these components are created and implemented in an eGate project. It is 
assumed that the reader understands the basics of creating a project using the 
SeeBeyond Enterprise Designer. For more information on creating an eGate project see 
the eGate Tutorial and the eGate Integrator User’s Guide.

What’s in This Chapter

CICS eWay Components on page 78

CICS eWay Sample Projects on page 79

The CICS_JCE_Sample Project Overview on page 80

The CICS_COBOL_Sample Project on page 97

5.1 CICS eWay Components
This chapter presents sample CICS eWay projects created using the same procedures as 
the sample end-to-end project provided in the eGate Tutorial. CICS eWay components 
that are unique to this eWay include the following:

CICS eWay Properties File

The Properties file for the CICS eWay contains the parameters that are used to connect 
with a specific external system. These parameters are set using the Parameters dialog 
box. For more information about the CICS eWay Configuration File and the Parameters 
dialog box see Creating and Configuring the CICS eWay on page 43.

CICS_eWay.CICSClient OTD

The CICS_eWay.CICSClient OTD is provided with the eWay and contains methods and 
attributes used to create the Business Rules that invoke the CICS program. 

Cobol Copybook Wizard

The Cobol Copybook Wizard allows the eGate Integrator to convert Cobol Copybook 
files into eGate Object Type Definition (OTD) files.
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5.2 CICS eWay Sample Projects
Two sample projects are defined in the following sections. 

CICS_JCE_Sample: a simple project that demonstrates the CICS eWay receiving 
data from a file, passing the data to the CICS External System, and writing the 
output from the CICS System to another file.

CICS_COBOL_Sample: demonstrates a simple CICS project that uses the Cobol 
Copybook Converter.

5.3 Importing a Sample Project
Sample eWay projects are included as part of the installation CD-ROM package. To 
import a sample eWay project to the Enterprise Designer do the following:

1 The sample files are uploaded with the eWay’s documentation .sar file and 
downloaded from the Enterprise Manager’s Documentation tab. The 
CICS_eWay_Sample.zip file contains the various sample project zip files. Extract 
the samples from the Enterprise Manager to a local file.

2 Save all unsaved work before importing a project.

3 From the Enterprise Designer’s Project Explorer pane, right-click the Repository 
and select Import from the shortcut menu. The Import Manager appears.

4 Browse to the directory that contains the sample project zip file. Select the sample 
file (for this sample, CICSjms_JCE_Sample.zip) and click Import. After the sample 
project is successfully imported, click Close. 

5 Before an imported sample project can be run you must do the following:

Create an Environment (see Creating an Environment on page 90)

Configure the eWays for your specific system (see Configuring the eWays on 
page 92)

Create a Deployment Profile (see Creating and Activating the Deployment 
Profile on page 94)
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5.4 The CICS_JCE_Sample Project Overview
The CICS eWay project, CICS_JCE_Sample, demonstrates the following:

Input data (ASCII text) is read from an external directory by the Inbound File eWay. 

The ASCII text data is converted to EBCDIC (byte array) using cp037 encoding, and 
published by the CICS eWay to the CICS external system.

The CICS eWay subscribes to the CICS external system, receives EBCDIC input 
data, and converts it to String ASCII data using cp037 encoding. The data is then 
published to the JMS Topic.

The outbound File eWay subscribes to the JMS Topic and publishes the data to an 
external directory.

Figure 49   CICS_JCE_Sample Project

5.5 Creating the CICS_JCE_Sample Project
The following pages provide step by step directions for manually creating the sample 
eWay components.

5.5.1. Creating a Project
The first step is to create a new project in the SeeBeyond Enterprise Designer.

1 Start the Enterprise Designer.

2 From the Enterprise Explorer’s Project Explorer tab, right-click your Repository on 
the Project Explorer tree and select New Project (see Figure 50 on page 81). A new 
project (Project1) appears on the Project Explorer tree.
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Figure 50   Enterprise Explorer - New Project

3 Click twice on Project1 and rename the project (for this sample, 
CICS_JCE_Sample).

5.5.2 Creating a Connectivity Map
The Connectivity Map provides a canvas for assembling and configuring a project’s 
components.

1 From the Project Explorer tree, right-click the new CICS_JCE_Sample project and 
select New > Connectivity Map from the shortcut menu. 

2 The New Connectivity Map appears and a node for the Connectivity Map is added 
under the project on the Project Explorer tree labeled CMap1. Rename the 
Connectivity Map to CICSjms_JCE_Sample_CM.

The icons in the toolbar represent the available components used to populate the 
Connectivity Map canvas. 

Selecting the External Applications

The icons in the toolbar represent the available components used to populate the 
Connectivity Map canvas.

In a Connectivity Map, the eWays are associated with External Systems. For example, to 
establish a connection to CICS, you must first select CICS as an External System to use 
in your Connectivity Map (see Figure 51). 

Figure 51   Connectivity Map - External Applications

1 Click the External Application icon on the Connectivity Map toolbar,
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2 Select the external systems needed for your project (for this sample, the CICS and 
File External Applications). Icons representing the selected external systems are 
added to the Connectivity Map toolbar.

Populating the Connectivity Map

Add the project components to the Connectivity Map by dragging the icons from the 
toolbar to the canvas. 

1 For this sample, drag the following components onto the Connectivity Map canvas 
as displayed in Figure 52: 

File External System (2)

Service (2) A service is a container for Collaborations, Business Processes, eTL 
processes, and so forth.

Topic

CICS External System

Figure 52   Connectivity Map with Components

2 Rename the objects by right-clicking the object, selecting Rename from the shortcut 
menu, and typing in the new name. Change the names as follows:

File1 to FileIn

Service1 to CICSjmsCollab

Service2 to JMS2FileCollab

File2 to FileOut

3 From the Enterprise Designer toolbar, click the Save All icon to save your current 
changes to the Repository.

5.5.3. Creating the Collaboration Definitions
The next step in the sample is to create two Collaborations using the Collaboration 
Definition Wizard (Java). Once the Collaboration Definitions have been created, the 
Business Rules of the Collaborations are written using the Collaboration Editor.
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Creating the CICSjms_Collab Collaboration

The CICSjms_Collab Collaboration defines transactions from the inbound file 
application to the CICS eWay and the CICS application, and back to the JMS Topic.

1 From the Project Explorer, right-click the sample project and select New > 
Collaboration Definition (Java) from the shortcut menu. The Collaboration 
Definition Wizard (Java) appears.

2 Enter a Collaboration Definition name (for this sample CICSjms_Collab) and click 
Next.

3 For Step 2 or the wizard, from the Web Services Interfaces selection window, 
double-click SeeBeyond > eWays > File > FileClient > receive. The File Name field 
now displays receive. Click Next.

4 For Step 3 of the wizard, from the Select OTDs selection window, double-click 
SeeBeyond > eWays > CICSeWay > CICS_eWay. The CICS_eWay OTD is added to 
the Selected OTDs field.

5 Click the Up One Level button to return to the Repository. Double-click SeeBeyond 
> eGate > JMS. The Selected OTDs field now lists the JMS OTD (see Figure 53). 

Figure 53   Collaboration Definition Wizard (Java) - Select Web Service Interface

6 Click Finish. The Collaboration Editor with the new CICSjms_Collab Collaboration 
appears in the right pane of the Enterprise Designer.

Creating the JMS2File_Collab Collaboration (Java)

The JMS2File_Collab Collaboration defines transactions made from the JMS Topic to 
the Outbound File eWay.

1 From the Project Explorer, right-click the sample project and select New > 
Collaboration Definition (Java) from the shortcut menu. The Collaboration 
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Definition Wizard (Java) appears.

2 Enter a Collaboration Definition name ( JMS2File_Collab) and click Next. 

3 For Step 2 of the wizard, from the Web Services Interfaces selection window, 
double-click SeeBeyond > eGate > JMS > receive. The File Name field now 
displays receive. Click Next.

4 For Step 3, Select OTDs, from the Select OTDs selection window, double-click 
SeeBeyond > eWays > File > FileClient. The Selected OTDs field now lists the 
FileClient OTD. 

5 Click Finish. The JMS2File_Collab Collaboration appears.

5.5.4. Using the Collaboration Editor (Java)
The next step in the sample is to create the Business Rules of the Collaboration using 
the Collaboration Editor. 

Creating the CICSjms_Collab Business Rules

The CICSjms_Collab Collaboration contains the Business Rule displayed in Figure 54.

Figure 54   CICSjms_Collab Business Rules
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To create the CICSjms_Collab Collaboration Business Rules do the following:

1 From the Project Explorer tree, double-click CICSjms_Collab to open the 
Collaboration Editor (Java) to the CICSjms_Collab Collaboration.

2 The imported sample includes comments with the Business Rules. To create 
comments for the Business Rules, click the comment icon on the Business Rules 
toolbar. The Enter a Comment dialog box appears. Enter the comment and click 
OK. The comment is placed on the Business Rules tree under the last selected item. 
Once the Comment is created, it can be moved by clicking the comment and 
dragging it up or down the Business Rules tree to a new location.

3 To create the Copy 50 to CICS_eWay_1.CommAreaLength rule do the following:

A From the Business Rules Designer Math menu, select Literal Number. The 
Number method box appears. Enter 50 as the value.

B Map the 50 output node of the Number method box to CommAreaLength 
under CICS_eWay_1 in the right pane of the Collaboration Editor. To do this, 
click on the 50 output node in the Number method box and drag the cursor to 
CommAreaLength under CICS_eWay_1 in the right pane of the Business Rules 
Designer (see Figure 55). 

Figure 55   CICSjms_Collab - Copy 50 to CICS_eWay_1.CommAreaLength Rule

4 To create the (variable) Copy new String(input.ByteArray) to variable temp1 rule 
do the following:

A From the Business Rules toolbar, click the Local Variable icon. The Create 
Variable dialog box appears.

B From the Create Variable dialog box, enter temp1 as the Name, and for Type, 
select Class and click the ellipsis (...) button. The Class Browser dialog box 
appears.

C From the Class Browser dialog box, select String under All Classes, and 
String(byte[] bytes) under String. Click Select. From the Create Variable dialog 
box, click OK. 

D Map ByteArray, under input in the left pane of the Business Rules Designer, to 
the bytes (byte[]) input node of the String method box.

E Map the result (String) output node of the String method box, to temp1 
(variable) in the right pane of the Business Rules Designer (see Figure 56).
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Figure 56   Copy new String(input.ByteArray) to variable temp1 Rule

5 To create the Copy temp1.Bytes["Cp037"] to CICS_eWay_1.CommArea rule do the 
following:

A From the Business Rules toolbar, click the rule icon to add a new rule.

B From the left pane of the Business Rules Designer, right click temp1 and select 
Select method to call from the shortcut menu.

C From the method selection box, click getBytes(java.lang.String charsetName). 
The getBytes method box appears.

D From the Business Rules Designer’s String menu, select Literal String. The 
String method box appears. Enter cp037 as the Value.

E Map the cp037 output node of the Stringl method box to the charsetName 
(String) input node of the getBytes method box. 

F Map the result (byte[]) output node of the getBytes method box to CommArea 
under CICS_eWay_1 in the right pane of the Business Rules Designer. The 
Collaboration Editor (see Figure 57).

Figure 57   Copy temp1.Bytes["Cp037"] to CICS_eWay_1.CommArea Rule

6 To create the CICS_eWay_1.execute rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule.

B From the left pane of the Business Rules Designer, right-click CICS_eWay_1 and 
select Select method to call from the shortcut menu.
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C From the method selection box, select execute(). The execute method box 
appears.

7 To create the (variable) Copy CICS_eWay_1.CommAreaString["Cp037"] to 
variable temp2 rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule.

B From the Collaboration Editor toolbar, click the Advance mode icon. The Java 
Source Editor appears as the bottom pane of the Collaboration Editor.

C From the Java Source Editor, replace //New rule with the following code:

String temp2 = CICS_eWay_1.getCommAreaString( "cp037" );

D From the Java Source Editor toolbar, click the Commit Changes icon. A new 
object named temp2 is added to the left pane of the Business Rules Designer.

8 To create the (variable) Create uninitialized variable jmstext (of type Message); 
rule do the following:

A From the Business Rules toolbar, click on the local variable icon. The Create 
Variable dialog box appears.

B From the Create Variable dialog box, enter jmstext as the Name, select class, and 
click the ellipsis (...) button. The Class Browser dialog box appears.

C From the Class Browser dialog box, select Message under All Classes and click 
Select. From the Create Variable dialog box, click OK.

D From the Collaboration Editor toolbar, click the Refresh Collaboration icon. A 
new object named jmstext is added to the left pane of the Business Rules 
Designer.

9 To create the Copy JMS_1.createMessage to jmstext rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule. 

B From the left pane of the Business Rules Designer, right click JMS_1 and select 
Select method to call from the shortcut menu.

C From the method selection box, select createMessage(). The createMessage 
method box appears.

D Map the result (Message) output node of the createMessage method box to 
jmstext in the right pane of the Business Rules Designer (see Figure 58).

Figure 58   Copy JMS_1.createMessage to jmstext Rule 
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10 To create the Copy temp2 to jmstext.TextMessage rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule. 

B Map temp2 in the left pane of the Business Rules Designer, to TextMessage 
under jmstext in the right pane of the Business Rules Designer.

Figure 59   Business Rules Designer

11 From the editor’s toolbar, click Validate to check the Collaboration for errors.

12 Save your current changes to the Repository.

Note: See the eGate Integrator User’s Guide for more information on editing 
Collaborations.

Creating the JMS2File_Collab Collaboration Business Rules

Be careful to open all nodes specified in the directions to connect to the correct item. 
The CICSjms_Collab Collaboration contains the Business Rule displayed in Figure 60

Figure 60   JMS2File_Collab Business Rules

To create the JMS2File_Collab Collaboration Business Rules do the following:

1 From the Project Explorer tree, double-click JMS2File_Collab to open the 
Collaboration Editor to the JMS2File_Collab Collaboration.

2 To create comments for the Business Rules, from the Business Rules toolbar, click 
the comment icon. The Enter a Comment dialog box appears. Enter the comment 
and click OK. The comment is placed on the Business Rules tree under the last 
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selected item. Once the Comment is created, it can be moved by clicking the 
comment and dragging it up or down the Business Rules tree to a new location.

3 To create the Copy input.TextMessage to FileClient_1.Text rule do the following:

A Select the New rule in the Business Rules pane.

B Map TextMessage under input in the left pane of the Business Rules Designer to 
Text under FileClient_1 in the right pane.

4 To create the FileClient_1.write rule do the following:

A From the Business Rules toolbar click the rule icon to add a new rule.

B From the left pane of the Business Rules Designer, right-click FileClient_1 and 
click Select method to call from the shortcut menu. The method selection box 
appears.

C Select the write method. The write method box appears.

5 From the editor’s toolbar, click Validate to check the Collaboration for errors.

6 Save your current changes to the Repository.

5.5.5. Binding the eWay Components
After the Collaborations have been written, the components are associated and 
Bindings are created in the Connectivity Map.

1 From the Project Explorer, double-click the Connectivity Map 
CICSjms_JCE_Sample_CM. The Enterprise Designer canvas now displays the 
CICSjms_JCE_Sample_CM Connectivity Map.

2 Drag and drop the CICSjms_Collab Collaboration from the Project Explorer to the 
first Service (CICSjmsCollab). If the Collaboration was successfully associated, the 
Service’s “gears” icon changes from red to green (see Figure 61).

Figure 61   Connectivity Map - Binding the Components
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3 Drag and drop JMS2File_Collab from the Project Explorer to the second Service 
(JMS2FileCollab). 

4 From the Connectivity Map canvas, double-click CICSjmsCollab. The 
CICSjmsCollab Binding dialog box appears with the CICSjms_Collab Rule.

5 From the CICSjmsCollab Binding dialog box, map FileClient Input (under 
Implemented Services) to the inbound FileIn External Application.

6 From the CICSjmsCollab Binding dialog box, map CICS_eWay (under Invoked 
Services) to the CICS1 External Application.

7 From the CICSjmsCollab Binding dialog box, drag JMS_1 (under Invoked 
Services) to Topic1 (see Figure 62 on page 90). 

Figure 62   Connectivity Map - Associating (Binding) the Project’s Components

8 Minimize the CICSjmsCollab Binding dialog box by clicking the chevrons in the 
upper-right corner.

9 From the Connectivity Map, double-click JMS2FileCollab. The JMS2FileCollab 
Binding dialog box appears with the JMS2File_Collab Rule.

10 From the JMS2FileCollab Binding dialog box, drag JMS input (under 
Implemented Services) to Topic1.

11 From the JMS2FileCollab Binding dialog box, drag FileClient_1 (under Invoked 
Services) to the outbound FileOut Application. 

12 Minimize the Collaboration Binding dialog box, and save your current changes to 
the Repository

5.5.6. Creating an Environment
Environments include the external systems, Logical Hosts, integration servers and 
message servers used by a project and contain the configuration information for these 
components. Environments are created using the Enterprise Designer’s Environment 
Explorer and Environment Editor.

1 From the Enterprise Designer’s Enterprise Explorer, click the Environment 
Explorer tab. 
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2 Right-click the Repository and select New Environment. A new Environment is 
added to the Environment Explorer tree.

3 Rename the new Environment to CICS_JCE_Sample_Env.

4 Right-click CICS_JCE_Sample_Env and select New CICS External System. Name 
the External System CicsExtSys. Click OK. CicsExtSys is added to the Environment 
Editor. 

5 Right-click CICS_JCE_Sample_Env and select New File External System. Name 
the External System FileExtSysIn and select Inbound File eWay as the External 
System Type. Click OK. FileExtSysIn is added to the Environment Editor.

6 Right-click CICS_JCE_Sample_Env and select New File External System. Name 
this External System FileExtSysOut and select Outbound File eWay as the External 
System Type. FileExtSysOut is added to the Environment Editor.

7 Right-click CICS_JCE_Sample_Env and select New Logical Host. The 
LogicalHost1 box is added to the Environment and LogicalHost1 is added to the 
Environment Editor tree.

8 Right-click LogicalHost1 and select New SeeBeyond Integration Server. A new 
Integration Server (IntegrationSvr1) is added to the Environment Explorer tree 
under LogicalHost1.

9 Right-click LogicalHost1 and select New SeeBeyond JMS IQManager. A new JMS 
IQ Manager (SBJmsIQMgr1) is added to the Environment Explorer tree under 
LogicalHost1. The Environment Explorer and Environment Editor appear as 
displayed in Figure 63.

Figure 63   Environment Editor - CICS_JCE_Sample_Env

10 Save your current changes to the Repository.
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5.5.7. Configuring the eWays
The CICS_JCE_Sample project uses three eWays, each represented in the Connectivity 
Map as a node between an External Application and a Service (see Figure 64 on 
page 92). eWays facilitate communication and movement of data between the external 
applications and the eGate system. 

Figure 64   Configuring the eWays and JMS Properties

The File eWay configuration parameters are configured from the Connectivity Map. 
The CICS eWay configuration parameters are set from both the Project Explorer or 
Connectivity Map and the Environment Explorer. To configure the eWays do the 
following:

Configuring the File eWays

1 Double-click the Inbound File eWay, select Inbound File eWay in the Templates 
dialog box and click OK.

2 The Parameters dialog box opens to the Inbound File eWay configuration. Modify 
the configuration for your system, including the settings for the Inbound File eWay 
in Table 7, and click OK. The configuration settings are saved for the eWay.

Table 7   Inbound File eWay Settings

3 In the same way, modify the Outbound File eWay configuration for your system, 
including the settings in Table 8, and click OK.

Table 8   Outbound File eWay Settings

Inbound eWay Connection Parameters

Directory C:/temp

Input file name Input*.txt

Outbound eWay Connection Parameters

Directory C:/temp

Output file name output%.dat

Inbound File eWay

Outbound File eWay

CICS eWay

JMS Properties Handle
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Configuring the CICS eWay

The CICS eWay configuration parameters must be set in both the Project Explorer and 
Environment Explorer. For more information on the CICS eWay configuration 
parameters and the Parameters dialog box, see Creating and Configuring the CICS 
eWay on page 43 or see the eGate Integrator User’s Guide.

For the CICS_JCE_Sample project, do the following:

Modifying the CICS eWay (Project Explorer) Configuration Parameters

1 From the Connectivity Map, double-click the CICS eWay. The Parameters dialog 
box opens to the CICS eWay project configuration properties.

2 Modify the CICS eWay (Project Explorer) configuration for your system, including 
the settings in Table 9, and click OK.

Table 9   CICS Project Explorer eWay Settings

Modifying the CICS eWay (Environment Explorer) Configuration Parameters

1 From the Environment Explorer tree, right-click the CICS External System 
(CicsExtSys in this sample), and select Properties. The Parameters dialog box 
opens to the CICS eWay environment-configuration properties.

2 Modify the CICS eWay environment-configuration for your system, including the 
settings in Table 10, and click OK.

Table 10   CICS Environment Explorer eWay Settings

CICS eWay Project-Configuration Parameters

Connector 
Set as directed, otherwise use the default settings

Class com.stc.eways.cics.CicsClientConnector

Connection Transport SeeBeyond CICS Listener

Type CICS

CICS Client 
Set as directed, otherwise use the default settings.

COMMAREA Length 1000

CICS Program CICS program to be run on server

CICS eWay Environment-Configuration Parameters

SeeBeyond CICS Listener Settings 
Set as directed, otherwise use the default settings

Host Host Name

Port TCP/IP Port Number

CICS Client Settings
Set as directed, otherwise use the default settings.

CICS Password Password of CICS user

CICS UserId This is the Id of the CICS user
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Note: CICS eWay properties may also be set from the Collaboration Editor (Java) or 
eInsight Business Rules Designer, in which case they will override the 
corresponding properties in the eWay’s configuration file. Any properties that are 
not overridden retain their saved settings.

5.5.8. Configuring the JMS Clients
When a Service is linked with a Queue (or Topic), the Enterprise Designer adds a JMS 
properties handle between the two (see Figure 64 on page 92). These JMS properties 
facilitate the transfer and, if necessary, translation of data within the eGate system. JMS 
configuration properties must be configured in both the Connectivity Map and the 
Environment Explorer. 

For more information on JMS configuration parameters see the eGate Integrator User’s 
Guide.

Modifying the JMS Connectivity Map Configuration Parameters

1 From the CICSjms_JCE_Sample_CM Connectivity Map, double-click the JMS 
properties handle located between the CICSjmsCollab and Topic1. 

2 The Properties sheet appears, containing the default environment-configuration 
properties. Click OK to keep the default settings.

3 Double-click the JMS properties handle located between Topic1 and the 
JMS2FileCollab Collaboration.

4 The Parameters dialog box appears, containing the default configuration 
parameters. Click OK to keep the default settings.

Modifying the JMS Environment Explorer Configuration Parameters

1 From the Environment Explorer tree, right-click the Message Server found under 
the Logical Host, and select Properties. The Properties sheet opens to the JMS 
Environment-configuration properties.

2 Modify the JMS Environment-configuration for your specific system and click OK.

5.5.9 Creating and Activating the Deployment Profile
A Deployment Profile is used to assign Collaborations and message destinations to the 
integration server and message server. Deployment Profiles are created using the 
Deployment Editor.

1 From the Enterprise Explorer’s Project Explorer, right-click the project 
(CICS_JCE_Sample) and select New > Deployment Profile. 

2 Enter a name for the Deployment Profile (for this sample CICS_JCE_Sample_DP). 
Make sure that the selected Environment is CICS_JCE_Sample_Env. Click OK.

3 Click the Auto Map icon as displayed in Figure 65 on page 95. The projects 
components are automatically mapped to their system window as seen in Figure 66 
on page 95. If any of the project components are not mapped automatically after 
Auto Map is used, those component can be mapped manually by following the 
appropriate steps below. Once all components are mapped, proceed to step 9.
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Figure 65   Deployment Profile - Auto Map

4 From the left pane of the Deployment Editor, drag CICSjmsCollab -> Topic1 
(External Application) to the CicsExtSys window.

5 From the left pane of the Deployment Editor, drag the FileIn -> CICSjmsCollab 
(External Application) to the FileExtSysIn window.

6 From the left pane of the Deployment Editor, drag the JMS2FileCollab -> FileOut 
(External Application) to the FileExtSysOut window.

7 Drag the following to IntegrationSvr1 in the LogicalHost1 window: 

CICSjmsCollab 

JMS2FileCollab

8 Drag the following two Topic components to MessageSvr1 in the LogicalHost1 
window as displayed in Figure 66: 

CICSjmsCollab -> Topic1 

Topic1 -> JMS2FileCollab

Figure 66   Deployment Profile

9 Click Activate. When activation succeeds, save the changes to the Repository.
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5.5.10.Running the Project
The following directions assume that the Enterprise Designer was downloaded to 
C:\ican50. If this is not the case, replace that location in the following directions with 
the appropriate location.

1 From the Enterprise Manager Downloads tab, download Logical Host - for win32.

2 Extract the file to the ican50\logicalhost2\logicalhost directory. You must specify 
the logicalhost2 directory for it to be created.

3 Navigate to C:\ican50\logicalhost2\logicalhost\bootstrap\config directory and 
open the logical-host.properties file using Notepad™.

4 Enter the following information in the appropriate fields:

Logical Host root directory: ican50\logicalhost2\logicalhost

Repository URL: http://localhost:port number/repository name

Repository user name and password: Your user name and password

Logical Host Environment name: CICS_JCE_Sample_ENV

Logical Host name: logicalhost2

Save your changes to logical-host.properties and close the file.

5 Run the bootstrap.bat file in the ican50\logicalhost2\logicalhost\bootstrap\bin 
directory.

6 Copy the sample input data file to the input directory.
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5.6 The CICS_COBOL_Sample Project
The CICS eWay project, CICS_Cobol_Sample, demonstrates the following:

The Inbound File eWay subscribes to an external directory, receives the data, and 
publishes the data to the CICS eWay. 

The CICS eWay, triggered by the data from the File eWay, does the following:

executes a CICS program on the external CICS system (mainframe)

reads the program's output (the contents of its COMM area)

copies the output into a Cobol Copybook OTD that is generated from the same 
data area description

OTD accessors selectively extract the value of select fields

This data is published to the outbound File eWay, which publishes the data to an 
external directory.

Figure 67   CICS_Cobol_Sample Project

The CICS_Cobol_Sample is available to import from the Installation CD-ROM 
package (see Importing a Sample Project on page 79 for more information). The 
following pages review how the CICS_Cobol_Sample project is created.

5.6.1. Creating a Project
The first step is to create a new project in eGate Enterprise Designer.

1 Start the Enterprise Designer.

2 From the Enterprise Explorer’s Project Explorer tab, right-click the Repository and 
select New Project. A new project (Project1) appears on the Project Explorer tree.

3 Click twice on Project1 and rename the project (for this sample, 
CICS_COBOL_Sample).

Input
Directory

Output
Directory

The CICS eWay copies the
COMM area output to the Cobol
Copybook OTD. Selected data is
then published to the File eWay

The CICS eWay
executes a CICS
program on the

external CICS system.

CICS
eWay

Inbound
File eWay

Outbound
File eWay

CICS External
Application
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5.6.2 Creating a Connectivity Map
The Connectivity Map provides a canvas for assembling and configuring a project’s 
components.

1 In Enterprise Explorer’s Project Explorer, right-click the new project 
(CICS_COBOL_Sample) and select New > Connectivity Map from the shortcut 
menu. 

2 The New Connectivity Map appears and a node for the Connectivity Map is added 
under the project on the Project Explorer tree labeled CMap1. Rename the CMap1 
Connectivity Map to CICS_COBOL_Sample_CM

Selecting the External Applications

1 Click the External Application icon on the Connectivity Map toolbar,

2 Select the external systems needed for your project (for this sample, CICS and File). 
Icons representing the selected external systems are added to the Connectivity Map 
toolbar.

Populating the Connectivity Map

Add the project components to the Connectivity Map by dragging the icons from the 
toolbar to the canvas. 

1 For the CICS_COBOL_Sample project, drag the following components onto the 
Connectivity Map canvas as displayed in Figure 68: 

File External System (2) 

Service

CICS External System

Figure 68   Connectivity Map with Components

2 Rename the objects by right-clicking the object, selecting Rename from the shortcut 
menu, and typing in the new name. Change the names as follows:

File1 to FileIn

File2 to FileOut
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3 Save your current changes to the Repository.

5.6.3 Creating an Object Type Definition
Object Type Definitions (OTDs) contain the data structures and rules that define objects. 
OTDs are used in the Enterprise Designer to create Collaboration Definitions for 
building data transformations. OTDs are created using the Object Type Definition 
Wizard. 

Using the Cobol Copybook Wizard

The CICS_COBOL_Sample project uses an OTD that is created using the Cobol 
Copybook Wizard. A sample Cobol data file, qan3glr1.cobol is available from the 
downloaded CICS eWay Samples folder. To create the Cobol Copybook OTD using the 
sample Cobol file do the following:

1 Copy the sample Cobol file, qan3glr1.cobol, from the installation CD-ROM to a 
temporary file.

2 From the Project Explorer, right-click the CICS_COBOL_Sample project, and select 
New > Object Type Definition from the shortcut menu. The OTD Wizard Selection 
dialog box appears. Select the Cobol Copybook Wizard and click Next.

3 From the Select Cobol Copybook Files page of the Wizard, navigate to the 
directory that contains the sample Cobol file. The sample file is now visible in the 
Available Files field (see Figure 69). 

Figure 69   Cobol Copybook Wizard - Select Cobol Files
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4 Select the sample Cobol file and click the Add button. The file is added to the 
Selected Files field. Click Finish.

5 A Message dialog box appears if the OTD is created successfully, and the OTD is 
added to the Project Explorer tree as qan3glr1.

5.6.4. Creating a Collaboration Definition (Java)
The next step is to create the CICS_COBOL_Collab Collaboration using the 
Collaboration Definition Wizard (Java). Once the Collaboration Definition has been 
created, the Business Rules of the Collaboration can be written using the Collaboration 
Editor (Java).

Creating the CICS_COBOL_Colab Collaboration

1 From the Project Explorer, right-click the CICS_COBOL_Sample project and select 
New > Collaboration Definition (Java) from the shortcut menu. The Collaboration 
Definition Wizard (Java) appears.

2 Enter a Collaboration Definition name (for this sample CICS_COBOL_Collab) and 
click Next.

3 For Step 2 of the Wizard, from the Web Services Interfaces selection window, 
double-click SeeBeyond > eWays > File > FileClient > receive. The File Name field 
now displays receive. Click Next.

4 For Step 3 of the Wizard, from the Select OTDs selection window, double-click 
SeeBeyond > eWays > CICSeWay > CICS_eWay. The CICS_eWay OTD is added to 
the Selected OTDs field.

5 Click the Up One Level button to return to the Repository directory. Double-click 
SeeBeyond > eWays > File > FileClient. The FileClient OTD is added to the 
Selected OTDs field.

6 Click the Up One Level button to return to the Repository directory. Double-click 
CICS_COBOL_Sample > qan3glr1. The qan3glr1 OTD is added to the Selected 
OTDs field. 

7 Click Finish. The Collaboration Editor opens to the new Collaboration in the right 
pane of the Enterprise Designer. 

5.6.5. The CICS_COBOL_Collab Business Rules
The the CICS_COBOL_Sample project uses one Collaboration created in the previous 
section, CICS_COBOL_Collab. 

CICS_COBOL_Collab Business Rules

The CICS_COBOL_Collab Collaboration contains the Business Rule displayed in 
Figure 70 on page 101. These rules are created using the Collaboration Editor (Java).
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Figure 70   CICS_COBOL_Collab Business Rules

To create the CICS_COBOL_Collab Business Rules do the following:

1 From the Project Explorer tree, double-click CICS_COBOL_Collab to open the 
Collaboration Editor to the Collaboration.

2 To create the Copy util.STCTypeConverter.toIntegerPrimitive(50) to 
CICS_eWay_1.CommAreaLength rule do the following:

A From the Business Rules Designer toolbar, click the Class Browser icon. The 
Class Browser dialog box appears. 

B From the Class Browser dialog box, select STCTypeConverter under All 
Classes, select toIntegerPrimitive(double arg0) under STCTypeConverter, and 
click Select. The STCTypeConverter.toIntegerPrimitive method box appears.

C From the Business Rules Designer’s Math menu, select Literal Number. The 
Number dialog box appears. Enter 50 as the value.

D Map the 50 output node of the Number method box to the arg0 (double) input 
node of the STCTypeConverter.toIntegerPrimitive method box. Do this by 
clicking on the 50 output node and dragging the cursor to the arg0 (double) 
input node.

E Map the result (int) output node of the STCTypeConverter.toIntegerPrimitive 
method box to CommAreaLength under CICS_eWay_1 in the right pane of the 
Business Rules Designer (see Figure 71 on page 102).
CICS eWay Intelligent Adapter User’s Guide 101 SeeBeyond Proprietary and Confidential



Chapter 5 Section 5.6
Implementing a CICS eWay Project The CICS_COBOL_Sample Project
Figure 71   Collaboration Editor - Business Rules

3 To create the (variable) Copy new String(input.ByteArray, "ISO8859_1") to 
variable triggerString rule do the following:

A From the Business Rules toolbar, click the Local Variable icon. The Create 
Variable dialog box appears. Enter triggerString as the Variable Name, and for 
Type, select Class and click the ellipsis (...) button. The Class Browser dialog box 
appears.

B From the Class Browser dialog box, select String under All Classes and click 
Select. From the Create Variable dialog box, click OK.

C From the Business Rules Designer’s String menu, select Literal String. The 
String (literal) dialog box appears. Enter ISO8859_1 as the value.

D From the Business Rules Designer toolbar, click the Class Browser icon. The 
Class Browser dialog box appears. Select String under All Classes, select 
String(byte[] bytes,String charsetName) under String, and click Select. The 
String (constructor) method box appears.

E Map ByteArray under input in the left pane of the Business Rules Designer, to 
the bytes (byte[]) input node of the String (constructor) method box. 

F Map the ISO8859_1 output node of the String (literal) method box, to the 
charsetName (String) input node of the String (constructor) method box.

G Map the result (String) output node of the String (constructor) method box, to 
triggerString in the right pane of the Business Rules Designer.

Figure 72   Collaboration Editor - Business Rules
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4 To create the Copy triggerString.Bytes["Cp037"] to CICS_eWay_1.CommArea rule 
do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule. 

B From the left pane of the Business Rules Designer, right click triggerString and 
select Select method to call from the shortcut menu.

C From the method selection box, select getBytes(String charsetName). The 
getBytes method box appears.

D From the Business Rules Designer’s String menu, select Literal String. The 
String (literal) dialog box appears. Enter cp037 as the Value.

E Map the cp037 output node of the String method box to the charsetName 
(String) input node of the getBytes method box. 

F Map the result (byte[]) output node of the getBytes method box to CommArea 
under CICS_eWay_1 in the right pane of the Business Rules Designer. 

5 To create the CICS_eWay_1.getServerList(1) Business Rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule. 

B From the left pane of the Business Rules Designer, right click CICS_eWay_1 and 
select Select method to call from the shortcut menu.

C From the method selection box, select getServerList(int arg0). The getServerList 
method box appears.

D From the Business Rules Designer’s Math menu, select Literal Number. The 
Number (literal) dialog box appears. Enter 1 as the Value.

E Map the 1 output node of the Number method box to the arg0 (int) input node 
of the getServerList method box (see Figure 73). 

Figure 73   Collaboration Editor - Business Rules

6 To create the CICS_eWay_1.execute Business Rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule.

B From the left pane of the Business Rules Designer, right click CICS_eWay_1 and 
select Select method to call from the shortcut menu.

C From the method selection box, select execute(). The execute method box 
appears on the Business Rules Designer canvas.
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7 To create the variable Create uninitialized variable resultBytes (of type byte array) 
rule do the following:

A From the Business Rules toolbar, click the Local Variable icon. The Create 
Variable dialog box appears. Enter resultByte as the Name. For Type, select 
Primitive and select byte as the value. Select the Is array, option and click OK.

8 To create the variable Create uninitialized variable resultBytesStream (of type 
ByteArrayInputStream) rule do the following:

A From the Business Rules toolbar, click the Local Variable icon. The Create 
Variable dialog box appears. Enter resultBytesStream as the Name. For Type, 
select Class and click the elipsis (...) button. The Class Browser dialog box 
appears. 

B From the Class Browser dialog box, select ByteArrayInputStream under All 
Classes and click Select.

C Frome the Create Variable dialog box, click OK.

9 To create the variable Create uninitialized variable otdStream (of type 
OtdInputStream) rule do the following:

A From the Business Rules toolbar, click the Local Variable icon. The Create 
Variable dialog box appears. Enter otdStream as the Name. For Type, select 
Class and click the elipsis (...) button. The Class Browser dialog box appears. 

B From the Class Browser dialog box, select OtdInputStream under All Classes 
and click Select.

C Frome the Create Variable dialog box, click OK.

10 To create the Copy CICS_eWay_1.CommArea to resultBytes rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule. 

B Map CommArea under CICS_eWay_1 in the left pane of the Business Rules 
Designer, to resultBytes in the right pane of the Business Rules Designer.

11 To create the Copy new ByteArrayInputStream(resultBytes) to resultBytesStream 
rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule. 

B From the Business Rules Designer toolbar, click the Class Browser icon. The 
Class Browser dialog box appears. 

C From the Class Browser dialog box, select ByteArrayInputStream under All 
Classes, select ByteArrayInputStream(byte[] buf) under ByteArrayInputStream 
and click Select. . Click OK. The ByteArrayInputStream method box is appears.

D Map resultBytes in the left pane of the Business Rules Designer, to the buf 
(Byte[]) input node of the java.io.ByteArrayInputStream method box. 

E Map the result (ByteArrayInputStream) output node of the 
ByteArrayInputStream method box, to the resultBytesStream node in the right 
pane of the Business Rules Designer (see Figure 74).
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Figure 74   Copy new ByteArrayInputStream(resultBytes) to resultBytesStream rule

12 To create the Copy new SimpleOtdInputStreamImpl(resultBytesStream) to 
otdStream rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule. 

B From the Business Rules Designer toolbar, click the Class Browser icon. The 
Class Browser dialog box appears. 

C From the Class Browser dialog box, select SimpleOtdInputStreamImpl under 
All Classes, and click OK. The SimpleOtdInputStreamImpl method box is 
appears on the Business Rules Designer canvas.

D Map resultBytesStream in the left pane of the Business Rules Designer, to the 
arg0 (int) input node of the SimpleOtdInputStreamImpl method box.

E Map the result (ByteArrayInputStream) output node of the 
ByteArrayInputStream method box, to the resultBytesStream node in the right 
pane of the Business Rules Designer

13 To create the qan3glr1_1.unmarshal(otdStream) rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule. 

B From the left pane of the Business Rules Designer, right click qan3glr1_1 and 
select Select method to call from the shortcut menu.

C From the method selection box, select 
unmarshal(com.stc.otd.runtime.OtdInputStream in). The unmarshal method 
box appears.

D Map otdStream from the left pane of the Business Rules Designer to the in 
(OtdInputStream) input node of the unmarshal method box.

14 To create the Copy qan3glr1_1.DFHCOMMAREA.CA_OUT_NAME to 
FileClient_1.Text rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule.

B Map CA-OUT-NAME under qan3glr1_1 > DFHCOMMAREA in the left pane 
of the Business Rules Designer to Text under FileClient_1 in the right pane of 
the Business Rules Designer.
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15 To create the Copy FileClient_1.Text.concat("/") to FileClient_1.Text rule do the 
following:

A From the Business Rules toolbar, click the rule icon to add a new rule.

B From the Business Rules Designer’s String menu, select Literal String. The 
String method box appears. Enter / as the Value.

C From the Business Rules Designer String menu, select concat. The concat 
method box appears.

D Map the Text under FileClient_1 in the left pane of the Business Rules Designer, 
to the String input node of the concat method box.

E Map the / output node of the Literal method box to the str (String) input node of 
the concat method box.

F Map the result (String) output node of the concat method box to Text under 
FileClient_1 in the right pane of the Business Rules Designer (see Figure 75).

Figure 75   Copy FileClient_1.Text.concat("/") to FileClient_1.Text rule

16 To create the Copy FileClient_1.Text.concat(qan3glr1_1.DFHCOMMAREA.
CA_OUT_CITY) to FileClient_1.Text rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule.

B From the Business Rules Designer String menu, select concat. The concat 
method box appears.

C Map the Text under FileClient_1 in the left pane of the Business Rules Designer, 
to the String input node of the concat method box.

D Map CA-OUT-CITY under qan3glr1_1 > DFHCOMMAREA in the left pane of 
the Business Rules Designer to the str (String) input node of the concat method 
box.

E Map the result (String) output node of the concat method box toText under 
FileClient_1 in the right pane of the Business Rules Designer (see Figure 76 on 
page 107).
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Figure 76   Collaboration Editor - Business Rules

17 To create the Copy FileClient_1.Text.concat("/") to FileClient_1.Text rule do the 
following:

A From the Business Rules toolbar, click the rule icon to add a new rule.

B From the Business Rules Designer’s String menu, select concat. The concat 
dialog box appears. 

C From the Business Rules Designer’s String menu, select Literal String. The 
String dialog box appears. Enter / as the Value.

D Map the / output node of the String method box to the str (String) input node of 
the concat method box 

E Map the Text under FileClient_1 in the left pane of the Business Rules Designer, 
to the String input node of the concat method box.

F Map the result (String) output node of the concat method box, to Text under 
FileClient_1 in the right pane of the Business Rules Designer.

18 To create the Copy FileClient_1.Text.concat(qan3glr1_1.DFHCOMMAREA.
CA_OUT_RETURN_CODE) to FileClient_1.Text rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule.

B From the Business Rules Designer’s String menu, Select concat. The concat 
method box appears.

C Map the Text under FileClient_1 in the left pane of the Business Rules Designer, 
to the String input node of the concat method box.

D Map CA-OUT-RETURN-CODE under qan3glr1_1 > DFHCOMMAREA in the 
left pane of the Business Rules Designer to the str (String) input node of the 
concat method box.

E Map the result (String) output node of the concat method box toText under 
FileClient_1 in the right pane of the Business Rules Designer.

19 To create the FileClient_1.write Business Rule do the following:

A From the Business Rules toolbar, click the rule icon to add a new rule. 
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B From the left pane of the Business Rules Designer, right click FileClient_1 and 
select Select method to call from the shortcut menu.

C From the method selection box, select write(). The write method box appears on 
the Business Rules Designer canvas.

20 From the editor’s toolbar, click Validate to check the Collaboration for errors.

21 Save your current changes to the Repository.

Note: See the eGate Integrator User’s Guide for information on editing Collaborations.

5.6.6. Creating Collaboration Bindings
After the Collaborations have been written, the components are associated and the 
Collaboration Bindings are created in the Connectivity Map.

1 From the Project Explorer, double-click the Connectivity Map 
CM_CICS_COBOL_Sample. The Enterprise Designer canvas now displays the 
CM_CICS_COBOL_Sample Connectivity Map.

2 Drag and drop the CICS_COBOL_Collab Collaboration from the Project Explorer 
onto CicsCobolCollab in the CICS_COBOL_Sample_CM Connectivity Map. If the 
Collaboration was successfully associated, the Collaboration’s “gears” icon changes 
from red to green.

3 Double-click CicsCobolCollab. The CicsCobolCollab Binding dialog box appears.

4 From the CicsCobolCollab Binding dialog box, drag FileClient input (under 
Source) to the Inbound File external application.

5 From the CicsCobolCollab Binding dialog box, drag the FileClient FileClient_1 
OTD (under Destination) to the outbound File external application. 

6 From the CicsCobolCollab Binding dialog box, drag the CICS_eWay 
CICS_eWay_1 OTD (under Destination) to the CICS external application. 

7 Minimize the CicsCobolCollab Binding dialog box. The Connectivity Map now 
appears similar to the Connectivity Map displayed in Figure 77.

Figure 77   Connectivity Map - Connecting the Project’s Components

8 Right-click the Repository in the Project Explorer and select Save changes to 
Repository to save your changes.
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5.6.7. Creating an Environment
Environments include the external systems, Logical Hosts, integration servers and 
message servers used by a project and contain the configuration information for these 
components. 

1 From the Enterprise Designer’s Enterprise Explorer, click the Environment 
Explorer tab. 

2 Right-click the Repository and select New Environment. A new environment is 
added to the Environment Explorer tree.

3 Rename the new environment to CICS_COBOL_Sample_ENV. 

4 Right-click CICS_COBOL_Sample_ENV and select New CICS External System. 
Name the External System CicsExtSys. Click OK. CicsExtSys is added to the 
Environment Editor. 

5 Right-click CICS_COBOL_Sample_ENV and select New File External System. 
Name the External System FileExtSysIn and select Inbound File eWay as the 
External System Type. Click OK. FileExtSysIn is added to the Environment Editor.

6 Right-click CICS_COBOL_Sample_ENV and select New File External System. 
Name this External System FileExtSysOut and select Outbound File eWay as the 
External System Type. FileExtSysOut is added to the Environment Editor.

7 Right-click CICS_COBOL_Sample_ENV and select New Logical Host. The 
LogicalHost1 box is added to the Environment and LogicalHost1 is added to the 
Environment Editor tree.

8 Right-click LogicalHost1 and select New SeeBeyond Integration Server. A new 
Integration Server (IntegrationSvr1) is added to the Environment Explorer tree 
under LogicalHost1.

9 Save your current changes to the repository.

5.6.8. Configuring the eWays
The CICS_COBOL_Sample project uses three eWays, each represented in the 
Connectivity Map as a node between an External Application and a Collaboration. 

The File eWay properties are configured from the Connectivity Map. The CICS eWay 
properties are set from both the Project Explorer’s Connectivity Map and the 
Environment Explorer. To configure the eWays do the following:

Configuring the File eWays

1 Double-click the Inbound File eWay and select Inbound File eWay in the 
Templates dialog box and click OK.

2 The Properties Sheet opens to the Inbound File eWay properties. Modify the 
properties for your system, including the settings for the Inbound File eWay in 
Table 7, and click OK. 
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Table 11   Inbound File eWay properties

3 In the same way, modify the Outbound File eWay properties for your system, 
including the settings in Table 8, and click OK.

Table 12   Outbound File eWay properties

Configuring the CICS eWay

The CICS eWay properties must be set in both the Project Explorer and Environment 
Explorer. For more information on the CICS eWay properties and the Properties Sheet, 
see Creating and Configuring the CICS eWay on page 43 or see the eGate Integrator 
User’s Guide.

For the CICS_JCE_Sample project, do the following:

Modify the CICS eWay Connectivity Map Properties

1 From the Connectivity Map, double-click the CICS eWay. The Properties Sheet 
opens to the CICS eWay Connectivity Map configuration properties.

2 Modify the CICS eWay Connectivity Map properties for your system, including the 
settings in Table 13 on page 110, and click OK.

Table 13   CICS eWay Connectivity Map Properties

Inbound eWay Connection Parameters

Directory C:/temp

Input file name Input*.txt

Outbound eWay Connection Parameters

Directory C:/temp

Output file name output%.dat

CICS eWay Connectivity Map Properties

Connector 
Set as directed, otherwise use the default settings

Class com.stc.eways.cics.CicsClientConnector

Connection Transport SeeBeyond CICS Listener

Type CICS

CICS Client 
Set as directed, otherwise use the default settings.

COMMAREA Length 1000

CICS Program CICS program to be run on server
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Modify the CICS eWay Environment Explorer Properties

1 From the Environment Explorer tree, right-click the CICS External System 
(CicsExtSys in this sample), and select Properties. The Properties Sheet opens to 
the CICS eWay Environment configuration .

2 Modify the CICS eWay Environment configuration properties for your system, 
including the settings in Table 14 on page 111, and click OK.

Table 14   CICS eWay Environment Explorer Properties

5.6.9 Creating and Activating the Deployment Profile
A Deployment Profile is used to assign Collaborations and message destinations to the 
integration server and message server. Deployment profiles are created using the 
Deployment Editor.

1 From the Enterprise Explorer’s Project Explorer, right-click the project 
(CICS_COBOL_Sample) and select New > Deployment Profile. 

2 Enter a name for the Deployment Profile (for this sample 
CICS_COBOL_Sample_DP). Select CICS_COBOL_Sample_ENV as the 
Environment and click OK.

3 From the Deployment Editor toolbar, click the Auto Map icon. The projects 
components are automatically mapped to their system window as seen in Figure 78 
on page 112. If any of the project components are not mapped automatically after 
Auto Map is used, those component can be mapped manually by following the 
appropriate steps below. Once all components are mapped, proceed to step 8.

4 From the left pane of the Deployment Editor, drag the Inbound -> Service1 
(External Application) to the FileExtSysIn window.

5 From the left pane of the Deployment Editor, drag the Service1 -> Outbound 
(External Application) to the FileExtSysOut window.

6 Drag the Service1 -> CICS1 (External Application) to the CicsExtSys window.

7 Drag Service1 and OTDProcessor1 to IntegrationSvr1 in the Logicalhost1 window 
(see Figure 78).

CICS eWay Environment Explorer Properties

SeeBeyond CICS Listener
Set as directed, otherwise use the default settings

Host Host Name

Port TCP/IP Port Number

CICS Client
Set as directed, otherwise use the default settings.

CICS Password Password of CICS user

CICS UserId This is the ID of the CICS user
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Figure 78   Deployment Profile

8 Click Activate. When activation succeeds, save the changes to the Repository.

5.6.10.Running the Project
The following directions assume that the Enterprise Designer was downloaded to 
C:\eGate50. If this is not the case, replace that location in the following directions with 
the appropriate location.

1 From the Enterprise Manager Downloads tab, click on Logical Host - for win32.

2 Extract the file to the eGate50\logicalhost3\logicalhost directory. You must specify 
the logicalhost3 directory for it to be created.

3 Navigate to C:\eGate50\logicalhost3\logicalhost\bootstrap\config directory 
and open the logical-host.properties file using Notepad™.

4 Enter the following information in the appropriate fields:

Logical Host rood directory: eGate50\logicalhost3\logicalhost 

Repository URL: http://localhost:port number/repository name

Repository user name and password: Your user name and password

Logical Host Environment name: CICS_COBOL_Sample_ENV

Logical Host name: logicalhost3

Save your changes to logical-host.properties and close the file.

5 Run the bootstrap.bat file in the eGate50\logicalhost3\logicalhost 
\bootstrap\bin directory.

6 Copy the sample input data file to the input directory.
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Chapter 6

Java Methods

A number of Java methods have been exposed to make it easier to set information in the 
eWay’s OTD Editor and to get information from it. These methods are contained in the 
CicsClient Class. 

What’s in This Chapter

The CicsClient Class on page 113

Packed Decimal Java Helper Methods on page 113

6.1 The CicsClient Class
The CicsClient class represents an OTD through which a Collaboration can invoke 
transaction programs on a CICS server. Nodes and methods are exposed so that the 
Collaboration can conveniently prepare a request for a CICS program, invoke the 
program, and get result from the program. The OTD also exposes nodes that 
correspond to eWay configuration parameters, to provide the means to dynamically 
override the preset eWay settings at runtime.

CICS Javadoc

The Javadoc is uploaded with the eWay’s documentation file (CICSeWayDocs.sar) and 
downloaded from the Documentation tab of the Enterprise Manager. To access the full 
Javadoc, extract the Javadoc to an easily accessible folder, and double click the 
index.html file. 

6.2 Packed Decimal Java Helper Methods
The Java helper methods for the toPackedDecimal class. These methods are not 
exposed in the Collaboration but are available for use. For example, to use the CopyTo 
method to obtain a Hex value in a byte array you would use the following code:

MyPacked.toPackedDecimal("327.00") ;
    System.out.println(  " Decimal value is : "  + MyPacked.toString() ) ;
    byte[] work_buf = new byte[7];
    MyPacked.CopyTo(work_buf, 7);
    for ( int  Ii = 0 ; Ii < 7 ; Ii++ ) 
    {
      int Ib = (int) new Byte(work_buf[Ii]).intValue();
      if (Ib < 16)
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      {
        System.out.println("  Byte" + Ii  + " Hexvalue = 0" + Integer.toHexString(Ib));
      }
      else
      {
        System.out.println("  Byte" + Ii  + " Hexvalue = " + Integer.toHexString(Ib));
      }
    }

This produces the following output:
Decimal value is : 327.00
Byte0 Hexvalue = 00
Byte1 Hexvalue = 00
Byte2 Hexvalue = 00
Byte3 Hexvalue = 00
Byte4 Hexvalue = 32
Byte5 Hexvalue = 70
Byte6 Hexvalue = 0c

These methods are described in detail on the following pages:

ContainerExists

Description

Checks to see if contents of a packed decimal are available.

Syntax

public com.stc.eways.cics.PackedDecimal boolean ContainerExists()

Parameters

None.

Return Values

Boolean

Throws

None.

CopyBack

Description

Builds a packed decimal from the payload in a byte array. The byte array must contain a 
valid packed decimal number.

Syntax

public com.stc.eways.cics.PackedDecimal void CopyBack(byte Origin[],
int Size)

ContainerExists on page 114 GiveElem on page 115

CopyBack on page 114 SetElem on page 116

CopyTo on page 115
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Parameters

Return Values

None.

Throws

None.

CopyTo

Description

Copies a packed decimal number to a byte array.

Syntax

public com.stc.eways.cics.PackedDecimal void CopyTo(byte Dest[],
 int Size)

Parameters

Return Values

None.

Throws

None.

GiveElem
Description

Returns a specified byte of a packed decimal number.

Syntax

public com.stc.eways.cics.PackedDecimal int GiveElem(int Ii)

Name Type Description

Origin[] byte Payload containing a valid packed 
decimal number. 

 Size int Size of the payload that contains the 
packed decimal number.

Name Type Description

Dest[] byte A byte array that the packed decimal 
number will be copied to. 

 Size int Size of the payload that contains the 
packed decimal number.
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Parameters

Return Values

int
Returns the value of the position.

Throws

None.

SetElem
Description

Sets the value of a specified byte in a packed decimal number.

Syntax

public com.stc.eways.cics.PackedDecimal void SetElem(int Ii, 
 byte Value)

Parameters

Return Values

None.

Throws

None.

Name Type Description

 Ii int  Position of the byte to be returned.

Name Type Description

 Ii int Position of the byte to be set.

 Value byte Value to set.
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